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Introduction
Today, everyone may access satellite imagery data over the Internet. Knowledge of where to find
and how to analyze satellite images enables you to independently verify the information provided
by the media or official statistics. Information concerning the environment, emergencies, and consequences of natural disasters can often be presented in speculative form. Therefore, the purpose of
this Practice Book is to teach students, pupils, and other interested people how to use satellite images
and processing tools, including GIS, to check and compare information, monitor processes and phenomena in time and space, critically interpret large amounts of data collected at different times and
related to different subjects.
The authors at the Geographic Information Systems and Remote Sensing Laboratory (GIS and RS
Laboratory) of the Junior Academy of Sciences of Ukraine, National Center (JASU) work towards
creating, adapting, and testing the GIS and remote sensing methods in science education practice. In
this revised and updated edition of the Practice Book, you will learn how to analyze satellite images
in Geographic Information Systems.
The purpose of the educational activities at our Laboratory is the development of a scientific type
of thinking in students through the formation of skills required for processing information derived
from primary sources, including satellite images, and analysis of data that confirm or refute the previously formed hypothesis.
The first Practice Book, Fundamentals of Remote Sensing (Part I), mostly describes the opportunities offered by EO Browser featuring the intuitive, simple interface and a large array of available
satellite images. The resource, however, has rather limited capabilities for the analysis of remotely
sensed data. The second Practice Book, in contrast to the first one, is somewhat more complex in
terms of the GIS use and is based on the QGIS open-source software. However, we will also continue
to work with EO Browser and discover new tools, such as Giovanni.
This Practice Book will teach you how to use remote sensing in the visible and radar bands to
assess the state of vegetation in the fields or forest changes, monitor water quality in reservoirs,
detect oil spills in seas, etc. You will work with digital terrain models, topographic maps, and other
cartographic materials, master the supervised classification, calculate various indices (vegetation,
water), find correlations between different indicators, perform regression analysis, and much more.
This Practice Book is supplemented by the QR-codes given at the end of each task. These are links
to the YouTube page of the GIS and RS Laboratory at the JASU. In this way, you may follow the
completion of tasks by one of our team members. In addition, as in the first Practice Book, we have
developed color tips for different headings, such as Definitions, Interesting to know, Additional task,
Check yourself, Important!
Definitions

…………………………………………………………………

Interesting to know

…………………………………………………………………

Additional task

…………………………………………………………………

Check yourself

Questions are presented in the form of a blank table

Important!

Important text is highlighted in red italics
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Instructions
QGIS Installation Instructions

QGIS is a free, open-source geographic information system with flexible functional modules that
is supported and actively improved by a group of volunteer developers. This program enables you to
visualize, edit, analyze data, design maps for printing, etc.
To download and install it to your computer, follow the link https://qgis.org/uk/site/ or just enter
QGIS in the Google search bar and go to the first site found. To download the installer to your computer, click the Download Now button. In the window that appears, you will see a list of all available
download options. QGIS can be installed on Windows, Mac OS X, Linux, BSD, and Android. There
are also different versions of this program: Long term release (stable version) and Latest release with
the most recent updates. We recommend that you install Long term release to avoid problems with
running the program. To complete the tasks given in this Practice Book, we will use QGIS 3.16.7
'Hannover' version.

Important! There are two versions of this application designed for 64- and 32-bit operating systems. You may check the type of operating system you are currently running on your computer via the
Control Panel → All Control Panel Items → System. Install the version that matches the operating system
of your computer.
The Documentation Section on the official QGIS website contains user guides and training
manuals for both beginners and experienced users. All these documents are available in different
languages.

Instruction for Downloading Images in EO Browser
1. Login to EO Browser website using your login and password. Click Login and enter your details.
Or sign up by clicking Free sign up on the left-hand pane. In the tab that opens, enter your personal information and log in to the portal by clicking Sign up. You will receive an email from Sentinel Hub asking you to confirm that you have signed up on the site. You need to click Verify e-mail
address.
Important! Check your spam folder to make sure the verification email didn’t end up there!
2. To find a satellite image of the area of your interest, you need to enter the location name in the
search bar in the upper right corner of the screen and select it from the drop-down list.
Important! The name can be written in both English and Ukrainian
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For example, you can find a satellite image of Mount Lico in Mozambique.

3. Select the following from the settings toolbar in the left corner of your screen:
•

Data source;

•

activate Advanced search;

•

Max.cloud coverage;

•

Time range;

Important! Do not enter the date from the keyboard but select it from the calendar, because the
input through the keyboard does not work.
•

сlick Search.

As a result, you will get a list of all available images that meet certain criteria.
4. View the images by scrolling through their list in the left sidebar, find the image that suits your
purposes, and save it. Click on the
tool next to the date of the corresponding image – a link for
image download in the zip format will appear.

5. Click on the SciHub link. To start the automatic download, you must also sign up on this resource.
If you have entered the correct login, the download will start automatically. Otherwise, a login and password window will appear on the Copernicus Open Access Hub.
You can sign up with SciHub at: https://scihub.copernicus.eu/dhus/#/home. Click the Login button in the upper right corner of your screen and select Sign up from the drop-down menu.
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Upon signing up, return to the start page and log in: your link to image downloading on EO
Browser page will activate automatically and archive download will start.

Instructions for Signing up with Giovanni Platform (NASA)
To sign up with Giovanni, simply enter the keywords “Giovanni NASA” in the search bar of a
browser, or follow the link: https://giovanni.gsfc.nasa.gov/giovanni/.
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By default, the site interface looks like this:

To get access to all the functions of the resource, we recommend that you sign up. For this purpose, click the Login button in the upper right corner. If you have already signed up, enter your login
details in the Username and Password fields. If you have not worked with this resource before, you
need to sign up by clicking the Register button.

You will see a registration form, where you need to enter personal data, in particular:
Username
Password that shall consist of lowercase and uppercase letters and numbers (at least eight characters)
Password Confirmation
First Name
Last Name
E-mail
Country (of residence), select from the list
Affiliation (with industry), select from the list
Study Area, select from the list
User Type, select from the list
Agreements, check the box
I’m not a robot, check the box
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Upon entering the information and selecting all the required fields, press the Register for earthdata login button.

A confirmation message with email and login will be sent to the address you provided during
registration.

If your device failed to open the page to log into the resource automatically, log in again using the
browser. Enter the login and password you provided during registration.
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Now, you have created an account with NASA's Giovanni platform.
Data Required for the Performance of the Tasks
For your convenience, you can find all satellite images we use in this Practice Book at:
https://cutt.ly/YGZV198. We also remind you that images can be downloaded from EO Browser, SciHubCopernicus, EarthExplorer USGS, LandsatLook, etc. At the end of each Task, there is a QR-code
with a link to a short video tutorial on the performance of the Task.
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1. Long-Term Climate Data
(according to Giovanni)
1.1. Studying Changes in NO 2 and CO 2 Concentrations in the
Atmosphere of Ukraine
Giovanni: an easier way to visualize Earth science data (from NASA website)1.
Giovanni is a platform that displays geo-referenced data from NASA satellites directly on the
Internet.
With a few clicks, data from various instruments on NASA satellites can be displayed in a variety
of formats, including area plots, time series, meridional averages, zonal averages, and vertical profiles, among others.
You can analyze phenomena ranging from the environment surrounding a Saharan dust storm to
the impact Hurricane Katrina had on ocean surface chlorophyll concentrations. Single and multiple
parameters can be plotted for specified ranges and periods.
Data is accessed and displayed via a collection of interfaces, each allowing the plotting of parameters from one or more satellite instruments. Rainfall, temperature, humidity, and gas concentrations
are just a few of the parameters provided.
“Giovanni is a particularly powerful tool for high school and undergraduate research and education, because it provides uncomplicated access to remote-sensing data and easy-to-use functions to
analyze the data,” said James Acker, a scientist with NASA's GES DISC, which developed the product.
“By manipulating imagery and conducting analyses – rather than simply looking at images – students gain a more comprehensive understanding of how remote-sensing data is used to investigate
Earth's interconnected geophysical and biological systems”.

Case
Nitrogen dioxide and carbon dioxide are inorganic chemical compounds found in the air that are
harmful to human health. Sources of emissions of these substances are internal combustion engines,
thermal power plants, factories, etc. At the end of March 2020, the European Space Agency (ESA)
published data on a significant reduction in nitrogen dioxide emissions in several major European
cities (Paris, Rome, and Madrid) compared to the average monthly concentrations in 2019.2 In China,
at the height of the COVID-19 epidemic, the harmful emissions into the atmosphere decreased by
20-30% compared to the same period in the previous three years.3 Two weeks after the UK imposed
lockdown, nitrogen dioxide pollution in some cities of the country decreased by 60% compared to
a similar period in 2019.4 How did the pandemic affect the nitrogen dioxide concentrations in the
atmosphere over Ukraine?
According to the Global Monitoring Laboratory5, the concentration of carbon dioxide worldwide
is constantly increasing (data available since 1980). Is it possible to monitor the concentrations of this
pollutant in our country with satellite observation data?
Task performance algorithm:
1. Sign up and log in to the Giovanni service under your account.
___________________________________________________

URL: www.nasa.gov/audience/foreducators/9-12/features/giovanni-an-easier-way.html
URL: https://www.esa.int/Applications/Observing_the_Earth/Copernicus/Sentinel-5P/Coronavirus_lockdown_
leading_to_drop_in_pollution_across_Europe
3
URL: http://www.esa.int/Applications/Observing_the_Earth/Copernicus/Sentinel-5P/COVID-19_nitrogen_dioxide_
over_China
4
URL: https://www.bbc.com/news/uk-england-52202974
5
URL: https://gml.noaa.gov/ccgg/trends/global.html
1
2
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2. Find and visually compare the average concentrations of nitrogen dioxide in the atmosphere of
Ukraine from June 15, 2014, to June 15, 2015, and from June 15, 2019, to June 15, 2020.
3. Make a graph of carbon dioxide concentrations in Ukraine over the entire period available in
Giovanni for this compound.
Instructions for self-guided work:
1. Signing up on the site. Official website: https://giovanni.gsfc.nasa.gov/giovanni/

Choose a date (year/month/day): in the Select Date Range (UTC) field, select the time for which
the program should generate an average map (June 15, 2014 – June 15, 2015). Select the display format: in the Select Plot field, specify the display method – Time-Averaged Map. You can learn more
about other ways of displaying information from the user guide.
2. Choose the location for the study from the Select Region (Bounding Box or Shape) field. The
program can process different areas under study: within the state borders of the country or rectangular- or square-shaped as specified by the user. Accordingly, if you need to display data for a certain
region, your selection shall cover a larger area and include that region. You can zoom in/out on the
map with your mouse wheel or the “– +” buttons, and move around the map using the
icon.
Choose the territory in the north of Ukraine that includes the city of Kyiv using the tool

.
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3. Select the variable to be investigated – nitrogen dioxide: choose Atmospheric Chemistry from
the Select Variables panel. From a new list that appears on the screen, select NO2 Tropospheric Column (30% Cloud Screened) to display the content of nitrogen dioxide in the troposphere layers);
click the Plot Data button to display the data.

Important! The content of nitrogen dioxide in this data set is represented in molecules/cm2. The
satellite sensor estimates the number of molecules in the vertical column between the satellite instrument
and the ground per area of the Earth’s surface. Thus, you obtain the value in molecules/cm2.
4. As a result, you will get a map representing the average (annual) nitrogen dioxide concentrations in the selected area. The difference in values on the map remains unnoticed under the standard
classification of the image because the gradation of symbols automatically sets the maximum value of
2.00000005e+16 while our area primarily falls in the range up to 0.50000005e+16; so we will change
the maximum data range from 2.00000005e+16 to 0.50000005e+16. To do this, select the Options
tool from Options. Set the maximum data range: “0.50000005e+16”, turn Smoothing on, and click
Re-Plot.

14

You will get a map of the average (annual) concentrations of nitrogen dioxide in the selected area.

This map will be stored at Giovanni and you do not need to save it separately. To proceed to the
next Task, click the Back to Data Selection button in the lower right corner of your screen.
5. Using the same algorithm, determine the average nitrogen dioxide concentration in the troposphere over the same area during the period from June 15, 2019, to June 15, 2020.

Under Layers, you can see the maps that have been created. Switching between them (left-clicking
on the name of the map), you can visually compare them.
Check yourself
Why and how, in your opinion, did the concentrations of nitrogen dioxide change in 2019-2020
compared to the period of 2014-2015?
What are the environmental consequences of
this change in atmospheric nitrogen dioxide concentrations?
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6. Now let’s analyze the concentrations of carbon dioxide, a gas that contributes to global warming,1 in the same area over the period from 2002 to 2017.
Carbon dioxide is one of the compounds that drive global climate change. Check how its concentrations have changed in the selected area over the entire period for which the data are available
in Giovanni. In the Select Plot field, specify the Time Series Area-Averaged display mode; this is a
standard graph of the average value for the selected period that shows the changes in the concentrations of carbon dioxide in the selected area. In the same section, Atmospheric Chemistry, we can see
the concentration of CO2 at different times, in particular during 2002-2012 and 2010-2017. Thus, the
CO2 concentrations for different periods (2002–2012 and 2010–2017) can be displayed as two different graphs. To do this, tick the box next to one of the two indicators, specify the appropriate time
series for which information was collected, and click Plot Data (data visualization).

___________________________________________________
1
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URL: https://edition.cnn.com/2019/05/13/health/carbon-dioxide-world-intl/index.html

You will get two graphs for 2002–2012 and 2010–2017.

The graphs can be downloaded separately by clicking on the Image button and saved as a picture,
or you can download different periods to your device and create a common graph in Microsoft Excel:
select CSV under Downloads from the History tab and you will see two CSV files because we have
processed two periods.
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Download both CSV files and combine them into Microsoft Excel (transfer the data that is missing to display the time series from 2002 to 2017).
Important! If the files are not displayed correctly on your device (there is no automatic splitting of information into two columns: date and carbon dioxide concentration), use the Text to Columns tool from the Excel menu bar. Select the first column and in the tool dialog box, select a tab
character (comma, period, space, semicolon, etc.) for splitting the information into the table columns.

Create a graph of CO2 concentrations from 2002 to 2017 in any format.

Graph of CO2 concentration from 2002 to 2017
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Check yourself
How much did the CO2 concentration increase from 2002 to 2017?
What trend does this graph show?
Try to forecast the change in CO2 concentrations in this area by 2032.
What other chemical compounds can be
investigated with Giovanni?
Scan the QR-code below to watch the video tutorial on the performance of this Task.

1.2. Analyzing Correlation Between Water Surface
Temperatures and Water Blooms in the Black Sea and the Sea
of Azov
The blooming of reservoirs is a mass development of phytoplankton, which causes a change in
the color of water and impairs the oxygen supply of water. One of its reasons is the inflow of minerals, especially phosphorus fertilizers, synthetic detergents, and organic pollutants. In the marine
environment, unicellular, microscopic, planktonic organisms, called phytoplankton or microalgae,
form the basis of the food chain, on which almost all other marine organisms depend. About 2%
of known phytoplankton species are harmful or toxic. Harmful algal blooms can adversely affect a
large number of different marine organisms, especially marine mammals, sea turtles, shorebirds, and
fish, causing immunological, neurological, or reproductive disorders. An example of this effect is the
death of 107 bottlenose dolphins along the Florida coast in the spring of 2004 due to the consumption of fish high in brevetoxins (Wikipedia). One of the factors that cause the growth and reproduction of phytoplankton is changes in water temperature. Rising temperature is also a manifestation of
global climate change. Satellite data of chlorophyll concentrations are used to analyze phytoplankton
development and water blooms. The concentration of chlorophyll is an indicator of the number of
photosynthetic microorganisms in the aqueous medium.
Task
Using data visualization on NASA's Giovanni portal, determine whether there is a correlation
between water temperatures and chlorophyll concentrations in the Black Sea and the Sea of Azov.
Task performance algorithm:
1. Create a map of the average chlorophyll concentrations in the Black Sea and the Sea of Azov
during summer in 2015-2019; determine the parts of the seas with higher concentrations of chlorophyll.
2. Create a map of the average water surface temperatures in the Black Sea and the Sea of Azov in
2015–2019.
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3. Create a map of the correlation between chlorophyll concentrations and water surface temperatures in 2019; determine in which sea (the Black Sea or the Sea of Azov) the correlation between
these factors is higher.
Instructions for self-guided work:
Open the resource https://giovanni.gsfc.nasa.gov.
1. Sign up or log into the portal (according to the instructions given in paragraph 1 of Task 1.1).
2. First, create a map of average chlorophyll distribution in the Black Sea and the Sea of Azov. To
do this, use the tool displaying the average seasonal long-term chlorophyll concentrations, i.e. create
a map of average chlorophyll concentrations during summer months (June – August) in 2015-2019.
The peak of water blooms in the Black Sea and the Sea of Azov is commonly observed in summer
(that is why we choose summer months), and the values averaged over the five years allow us to neutralize possible extreme weather conditions, which were seen during one year only. So, in the Select
Plot field, pick Monthly and Seasonal Averages.

In the Select Seasonal Dates dialog, specify JJA (from English June, July, August – i.e. summer
months), and set the period: 2015 to 2019.

In the Select Region field, click the first tool
to draw a rectangle on the map, and in the window that opens, mouse over the Black Sea and the Sea of Azov.
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Click on
in the upper corner of your screen to close the window.
Specify the data for analysis: in the left pane Select variable, expand the Measurements tab, and
check the box next to Chlorophyll.

As a result, a table will appear in the center of your screen featuring a list of data sets that contain information about the concentrations of chlorophyll. This information includes the name of the
variable, units of measurement, source, temporal resolution, spatial resolution, and the beginning
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and ending dates of the data collection. Select the chlorophyll concentration data according to MODIS-Aqua satellite and click on the Plot Data (data visualization) tool.

As a result, you will get a map of average chlorophyll concentrations during the summer months
in 2015–2019. The map shows high concentrations of chlorophyll in the Sea of Azov as well as along
the eastern coast of the Black Sea.

With the Download tool, you can download the map, namely in the GeoTiff format, and, if necessary, continue to work with it in QGIS.

3. Now let’s create a map of sea surface temperatures for the same period and season. To return to
data selection, click the Back to Data Selection button in the lower right corner of your screen.
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4. Leave unchanged the following search parameters: visualization mode, season, years, and region (these parameters should be the same as in paragraph 1.2.1; we need to specify only the variable – sea surface temperature; we will use the search bar to select this parameter; to search you can
write keywords in English (the language of the program's web interface). So, enter “sea surface temperature”. All you have to do is to start writing a phrase, and a drop-down menu with possible data
options will open automatically. Select the appropriate data set and click Search.

From the list of available data sets, select the Sea Surface Temperature at 11 microns (Day) data set
with a spatial resolution of 4 km and click on the Plot Data tool.

As a result, you will get a map of the sea surface temperatures in the Black Sea and the Sea of Azov.

As can be seen from the map, almost the whole area has a surface temperature above 24oС. Using
the Options tool (as in the previous Task), you can change the scale so that the values from 20oC and
above are displayed only.
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As a result, you will get a map that shows that the highest sea surface temperature is observed in
the Sea of Azov, as well as off the west coast of the Black Sea.

Check yourself
Why do you think the water temperature in the
Sea of Azov is higher than that on the west coast
of the Black Sea?
5. Now we will determine whether there is a relationship between temperature and chlorophyll
concentration. To return to the data selection, click on the Back to Data Selection tool in the lower
right corner of your screen. Pick Map, Correlation under Select Plot.
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This visualization mode allows you to analyze only two phenomena over a certain period, without
averaging over the season. Therefore, you need to update the data in the Select Date Range field and
specify the period: from January 1, 2019, to December 31, 2019.
In the left sidebar, expand the Measurements tab again and select two variables: Chlorophyll and
Sea Surface Temperature, and click the Plot Data button.

As a result, you will get a map that displays areas of high and low correlations between the selected
variables. The map shows that in the areas with commonly high concentrations of chlorophyll (the
Sea of Azov and the west coast of the Black Sea), there is a direct relationship between temperature
and chlorophyll.
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6. Now let's take a look at the graph of the relationship between these variables. To do this, return
to the data selection tab and choose Scatter, Area Averaged (Static) from the Select Plot field and
click the Plot Data button.

As a result, a graph of the relationship between water temperatures and chlorophyll concentrations will appear. According to the graph, there is a dependence, however, the correlation coefficient
is quite low (0.35) for the whole area under study. This coefficient may slightly vary, depending on
the area selected for the study.
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7. We will change the area under study now and draw a rectangle for the territory of the Azov Sea
only, and build again a graph for the temperature-chlorophyll correlation.

The resulting correlation coefficient is 0.9, which indicates a close relationship between the water
temperature in the Sea of Azov and the concentration of chlorophyll.
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Check yourself
Why do you think the correlation coefficient
between temperature and chlorophyll was higher
in the Sea of Azov than in the Black Sea?
Scan the QR-code below to watch a video tutorial on the performance of this Task.
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2. Land Cover – Satellite Data
for Monitoring Ground Cover
Satellite imagery is a handy tool for tracking space changes, analyzing changes in different types of
land cover, such as forest, riverbed, shoreline, steppe areas, urban boundaries, or agricultural fields.
In the examples below, we will discuss how satellite imagery helps to track changes in the shoreline
that may result from the shallowing or such phenomena as abrasion and erosion – flooding and destruction of shores. We will also analyze how the forest cover in the highlands of the Carpathians has
changed in almost a hundred years.

2.1. Analyzing the Tuzly Lagoons Coastline Changes by
Comparing the Satellite Map of the Land Cover and the
Topographic Map
Case
The Tuzly Lagoons National Nature Park located in the Tatarbunary District of Odesa Oblast is a
system of marine lagoons, Shahany – Alibey – Burnas, separated from the Black Sea coast by a 29-km
long and 60–400 m wide sandbar. It was created in 2010 to protect the unique and vulnerable Black
Sea flora and fauna. The place has become a refuge for a large number of different birds: a total of
240 species were recorded in this National Nature Park. It is here that you can watch pelicans in their
natural environment in Ukraine. This area is very sensitive to the influence of natural and anthropogenic factors that can lead to the drainage of estuaries and the loss of habitats for a huge number of
plants and animals.
Task
Determine whether the coastline of the Tuzly Lagoons has changed in recent years.
Task performance algorithm:
1. Open the OpenStreeMap layer and a topographic map of the Shahany-Alibey-Burnas lagoons
in your project.
2. Using EO Browser, download a map of the land cover of the Tuzly Lagoons National Nature
Park, created based on new satellite imagery of the area under study.
3. Visually compare how the land cover of the Tuzly Lagoons National Nature Park has changed
using the data of new satellite surveys and previous data.
Data for the performance of this Task can be downloaded at https://cutt.ly/YGZV198 or using EO
Browser.
Instructions for self-guided work:
1. Open QGIS Desktop 3.10.3 with GRASS 7.8.2 and create a new project.
2. Make sure that the Browser panel, the Layers panel, and the Spatial Bookmarks panel are open.
If they are not available, select View → Panels from the top menu and tick boxes next to Browser,
Layers, and Spatial Bookmarks Manager.
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Important! All toolbars in QGIS 3.16 are dynamic, i.e. you can change their placement in the
work view of the program.
3. Add an OpenStreetMap base map to the project. In the Browser panel, open XYZ Tiles and
double-click on the OpenStreetMap layer to open it in the Layers and display it in the map window.
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4. Zoom to Odesa Oblast, Tatarbunary District, and Shahany estuary on the map. You will see
the area highlighted in green, which is delineated by the boundaries of the Tuzly Lagoons National
Nature Park – a group of estuaries separated from the sea by a narrow strip.

5. Open the topographic map layer in the project. Again, use the XYZ Tiles tool to create a new
connection to an online mapping service. The OpenStreetMap is a standard mapping service, so it
does not need to be configured. Other services can be additionally connected independently. For example, the OpenTopoMap service allows you to connect a layer with a topographic map to a project.
To do this, right-click on the XYZ Tiles menu in the Browser panel and select New Connection from
the drop-down list.

31

In the window that opens, enter the name of the new connection in the Name field, e.g. “topographic
map”, enter https://tile.opentopomap.org/{z}/{x}/{y}.png in the URL box and click Ok.

As a result, the topographic map layer will appear in the Browser panel. Double-click on its name
to open it in your project.

32

6. Have a look at the territory of the Park on the topographic map. Compare the display of the area
on the topographic map and OpenStreetMap map. One of the important advantages of topographic
maps over other electronic maps is that they contain terrain information that is displayed as contours. We will discuss them in more detail in one of the following sections.
7. Download the satellite map of the land cover based on Sentinel-2 data using EO Browser (or
open the data available for this Task at https://cutt.ly/YGZV198).
8. The land cover map was obtained by automatical classification of the Sentinel-2 satellite image
according to an algorithm developed by the European Space Agency. It is distributed as one of the
image bands with an L2A processing level. In fact, the ability to quickly classify a satellite image to
detect certain features on the ground surface and find relevant information about the location, shape,
and area of the land cover is one of the most important examples of satellite imagery use. The Sentinel-2 Scene Classification Map is the result of classifying an image into 11 classes of land cover. Let's
download such a map of the Tuzly Lagoons National Nature Park area.
Open EO Browser and log in (see “Instructions for Downloading Images from EO Browser” in
the “Instructions” section). Find the area of the Tuzly Lagoons National Nature Park on the map. In
the Search tab, select:
•

Data source: Sentinel-2;

•

activate Advanced search and select L2A (atmospherically corrected);

•

Max.cloud coverage: 0 (for the analysis of land cover, it is better to use completely cloudless
images unless you need data for a definite period);

•

Time range: 2020-05-01 – 2020-06-30.
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Switch to the Search tab and select the image taken on June 6, 2020, from the search results, and
click Visualize.

Select Scent classification map mode from the menu for setting up image display (visualization),
click on it and expand the tab with a description of this display method.
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As a result, the image will be displayed as a map of the land cover, and in the description of the
display mode, we can see the colors, in which different classes of land cover appear. In this Task, we
study the changes in the coastal area, therefore, the following classes are important for its performance: “water” displayed in blue, “vegetation” displayed in green, and land cover without vegetation
(non-vegetated) displayed in yellow on this map.
Check yourself
What type of land cover predominates
within the area under study?
Download this map using the Download image tool .
Context: In the image download window, open the Analytical tab and specify:
•

Image format: TIFF;

•

Image resolution: High;

•

Coordinate system: WGS 84;

•

Layers: Scene classification map.

Important! Note that the image will be automatically cropped along the map window, so make
sure that the map completely covers the area of your interest (in this case, the National Nature Park
area) before downloading.
Click Download and specify the path to the folder for saving the map.
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9. Open the downloaded map of the land cover in the QGIS project using the Browser menu and
find the changes in the coastline by comparing the map of land cover based on satellite imagery in
June 2020 and the topographic map.
10. Adjust the transparency of the land cover map so that you can see how the boundaries of
the land cover types have changed. To do this, switch to the properties of the land cover map (double-click with your left mouse button on the layer in the Layers). In the Layer Properties tab, open
Transparency and set “15” by dragging the slider or entering this value in the Global opacity box,
and click OK.

11. By overlapping the images in this way, you can see the areas of shallowing at the lagoons: i.e.
the areas displayed on the map as water bodies, in June 2020, no longer appear as such on the land
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cover map, created based upon satellite images. These areas, namely, include the Solone, Ozero near
Sadove settlement, and Khadzhyder Lagoon located near Lyman Town.

Important! To see more clearly the difference in the shallowing of lagoons, you can activate the
map layer display (tick the box next to the layer name in the Layers) by unchecking the layer “2020 – 0606…”. Only the topographic map will be displayed.
Check yourself
What is the type of land cover in the areas that
are displayed as water bodies on the topographic
map and appear differently on satellite imagery taken in June 2020?
According to the post published on the Facebook page of the Tuzly Lagoons National Nature Park
on June 17, 2020, “Residents of the villages bordering the Tuzly Lagoons National Nature Park have
also been affected by the drought. Currently, the condition of the reservoirs of the Tuzly Lagoons is
critical. Due to the lack of proper water exchange between the lagoons and the Black Sea and as a
result of the drought occurring in recent years, the area of the Llagoons has decreased by about 5
thousand hectares. These areas served as feeding grounds for waterfowl. All the inhabitants of Earth
need to take care of the environment, rationally use natural resources, enhance soil fertility, and save
energy resources to maintain the planet's ecological balance.”
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View of the dried-up areas of the Tuzly Lagoons National Nature Park (illustration taken from
https://www.facebook.com/permalink.php?story_fbid=3287018108022144&id=432082570182393)
Scan the QR-code below to watch a video tutorial on the performance of this Task.

2.2. Changes in the Upper Boundary of the Maramures Forest
Massif
,
Case
The upward shift of the forest upper boundary in the Ukrainian Carpathians is considered to be
one of the signs of climate change. The gradual increase in temperature, especially in mountains,
leads to a shift of the climatic alpine zone, where the temperature is one of the limiting factors for
the growth of trees and shrubs. Such changes do not occur in a year or two, or even several decades,
therefore, they are difficult to detect using satellite imagery of the Earth's surface only. However,
historical topographic maps enable us to identify long-term changes that occurred even hundreds of
years ago.
Task
Evaluate the changes of the forest cover, namely the upper forest boundary near Pip Ivan Mountain (Maramureș) using the topographic maps created in the early 20th century in the Austro-Hungarian Empire, the area under study belonged to at that time.
Task performance algorithm:
1. Download a topographic map of the early twentieth century capturing the area under study
(https://drive.google.com/drive/folders/1evecAx26lG1n_1M1w5cKgCNhZNwvUvI_).
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2. Vectorize the boundaries of the alpine zone (i.e. the zone of the upper forest boundary) in the
area of Pip Ivan Mountain (Maramureș) on a topographic map.
3. Open a layer of satellite imagery with high spatial resolution in the project and evaluate the
changes in the forest boundaries over almost 100 years.
Instructions for self-guided work:
1. Open QGIS Desktop 3.10.3 with GRASS 7.8.2 and create a new project.
2. Download a topographic map of the early twentieth century capturing the area under study. There
are several online resources with open-access historical topographic maps from which you can freely
download geo-referenced maps (in geotiff or geojpg formats), in particular of the Austro-Hungarian
Empire, which included part of modern Ukraine. Such maps can be immediately opened in the project
and compared with other cartographic data layers. For example, the site www.oldmapsonline.org/
allows you to search for the required location on the map and view and download historical maps of various
scales available in the catalog. To detect the changes in the upper forest boundary, we need maps with a
sufficient level of detail, in particular 1:50 000 and more. First, find a map of Pip1 Ivan Mountain (Maramureș)
area with a scale of 1:20 000 published in 1940. To do this, use the interface of www.oldmapsonline.org/
website or download the map directly from http://igrek.amzp.pl/details.php?id=11789222, where you
need to click on the first link (on the map) and specify the path for download. As a result, you will get
a geo-referenced map.

Mapstser web platform is a catalog of digital cartographic data available for non-commercial use
(link to the resource: http://igrek.amzp.pl/).
3. After downloading the map, open it in your project and find Pip Ivan Mountain.

____________________________________________________
1

On the digitized topographic map used in this Task, the name of this mountain is Pop Ivan.
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Check yourself
What is the height of Pip Ivan Mountain according to
the topographic map? Find a Wikipedia page about Pip
Ivan (Maramures) and see if the height indicated in this
article differs. If yes, why do you think?
4. Create a new polygonal vector layer to vectorize the alpine zone (i.e. the zone of the upper forest
boundary). From the toolbar, select New shapefile layer . In the window that opens, next to the File
name field, click on the tool
to find the required folder to save a new vector layer with selected
areas of felling. Enter its name, for example, “grass1940”, and click Save.
Important! The name of the thematic layer should be specified in Latin without additional
characters otherwise some tools may operate inappropriately (this also applies to the names of folders to
which you save your files).

Next, select Polygon from the drop-down list under Geometry type in the New Shapefile Layer
dialog box because the shape and area are important for forest display on the map.
Below the geometry field, there is another drop-down list containing the names of the map projections. Expand the list and select the WGS 84 / UTM zone 35N projection. This list contains projections

40

that are most commonly applied by the user; if you haven't specified a projection yet, it may be missing
in the list. In this case, click on
and in the window that opens, write WGS 84 / UTM zone 35N in
the Filter field.

As a result, this projection will be displayed in the Coordinate Reference System window; you
need to select it and click Ok.
Next, in the window to create a vector layer, click Ok, and a new layer will open in your project.

5. Now take a look at the map and determine how the forest boundary is marked on it. In this
series of historical Austro-Hungarian maps the following symbols are used:
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Forest boundary (the forest is
located on the side of the points
and circles)

Terrain isolines
(horizontals)

Rocks and rocky cliffs

Sparse forests

Names and height of peaks

Height symbols

Paths, roads
6. In QGIS, vector layers are edited with standard tools, as well as additional tools. By default, additional tools are not displayed in the top toolbar, therefore, you need to expand them first.
7. So, first activate the vector layers editing mode: select the layer you want to edit (in our case,
“grass1940”) in the Layers tab, left-click on it, and click on the Toggle Editing
tool. The icons of
the tools appear grey because they are not active at first. This toolbar contains many useful tools,
but first, you need to know the main thing – how to start and finish drawing the polygon.
You may notice that with enabled editing mode, some tools have colored icons, i.e. they became
active. One of them is a tool for digitizing polygons, Add Polygon Feature
. Select it and start
delineating the boundaries of the alpine zone (end of the forest).
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You can move the map during vectorization by holding down the mouse wheel or by using the
left/right/up/down keys on the keyboard. The entire boundary of the alpine zone can be vectorized
as one polygon. You can also zoom in/out the map while editing with your mouse wheel. At the top
and bottom of the map, the forest boundary is broken. In this example, you can simply draw a line
along the top of the map and continue digitizing, as shown below.

To finish digitizing, right-click, and in the window that appears, click Ok.
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Next, click the Save
tool, and then click Toggle Editing . If changes have not been saved before selecting this feature, a window will appear asking you to save the edited data. Click Save if you
want to save all changes.
As a result, a vector layer will be created as shown in the figure below.

1. Connect a layer with contemporary satellite imagery of high spatial resolution to see how the
forest boundary has changed. To do this, right-click on the XYZ Tiles menu in the Browser panel and
select New Connection from the drop-down menu.
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In the window that opens, specify the name of the new connection, e.g. "bing image", in the Name
field, and enter http://ecn.t3.tiles.virtualearth.net/tiles/a{q}.jpeg?g=1 in the URL line and click Ok.

The new bing image layer will appear in the XYZ Tiles menu list on the Browser panel; double
right-click to add it to the project.
1. Drag the “grass1940” vector layer in the Layers so that it appears the first in the list of layers
and is not overlapped with other layers, and make it transparent using the Properties / Symbology
window.
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As a result, both the satellite image and the boundaries of the alpine zone must be visible at the
same time.
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Check yourself
Analyze whether there is a shift in the
upper forest boundary. Is the upward shift of
the forest boundary occurring evenly? Why
do you think so?
Scan the QR-code below to watch a video tutorial on the performance of this Task.
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3. Combination of Bands – Detecting Spectral Patterns
of Features
3.1. Highlighting the Rainforest Boundaries on Mount Liko in
Mozambique
Case
It’s the 21st century, and probably each of you is sure that the epoch of geographical discoveries is
well behind, and the world has been fully explored. Indeed, it is very unlikely that people will be able
to find an area that has not been bulldozed, damaged by fire, exploited for mining, deforestation, or
simply littered. However, in the spring of 2018, a researcher from Wales, Dr. Julian Bayliss, led a team
of 28 people who started on an expedition to Mount Liko in Mozambique. This mountain has almost
vertical inaccessible slopes, and the forest on its top is completely isolated from human impact. The
scientist made his geographical discovery – he spotted a forest hidden from the human eye on the
Google Earth satellite images.1
Task
Using a satellite image, determine what type of forest is on Mount Liko (Mozambique), calculate
the approximate area of forest on the mountain, and assess the value of ecosystem services it provides
to the region.
Task performance algorithm:
1. Enable the QuickMapServices plug-in and download the OpenTopoMap.
2. Merge the bands in natural colors.
3. Save a map area near Mount Liko.
4. Merge bands B12, B8A, B04 (SWIR, Vegetation Red Edge, Red).
5. Calculate the forest area on the mountain using the Measure tool.
6. Calculate the cost of the ecosystem services for this forest area.
Instructions for self-guided work:
1. Data for this Task can be downloaded from https://cutt.ly/YGZV198 or using EO Browser
(Sentinel-2a image dated November 12, 2019, of the Mount Liko area).
2. The name of the Sentinel image folder may seem scary as it contains many numbers and letters,
which, at first glance, are not clear and complex. The Figure below explains what is encrypted in this
mysterious code; all Sentinel-2 products get their names according to a similar convention and provide details of the satellite, date of the image, height of the orbit, etc.

___________________________________________________

URL: www.theguardian.com/world/2018/jun/17/mozambique-mount-lico-rainforest-new-species
URL: www.theverge.com/2018/8/28/17770988/google-earth-mount-lico-discovery-secret-mozambique-rainforestexpedition
1
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Check yourself
Interpret the name of the Sentinel satellite image
that we will use in this task?
It is important to note that the Sentinel-2 image archive includes many folders and accompanying
data, while the bands we will work with are contained in the “IMG_DATA” subfolder (in jpg format).
The path to this folder is shown in the Figure below.

If you are interested in finding out the purposes and content of other folders, we recommend reading
the Sentinel-2 User Handbook (p. 60): https://earth.esa.int/documents/247904/685211/Sentinel-2_
User_Handbook.
We hope that the previous tasks did not cause any difficulties and you successfully found the right
folder. So let's start performing the Task in QGIS.
3. Open QGIS application and create a new project. Make sure that the Browser, the Layers, and
the Spatial Bookmarks panels are open in your project. If they are not available, select View → Panels
from the top menu and tick the boxes next to Browser, Layers, and Spatial Bookmarks.

49

The first step is to add the QuickMapServices plugin. To do this, select the Not installed tab under Plugins – Manage and Instal Plugins ... from the main menu. In the search bar, start typing the
plugin name, "QuickMapServices" or simply "QMS", and it will automatically appear in the list at the
bottom of the window. Select this plugin from the list by left-clicking, and brief information about it
will display automatically. Read this information, click Install Plugin, and close the dialog box. Once
installed, the plugin will appear on the Installed tab.
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QuickMapServices plugin will now be located in the top menu Web, and new buttons
.
will be added to the toolbar. Click Search QMS if you have not enabled it yet, and a new panel will
be added to the QGIS work window. In this panel, type “Topomap” in the search bar, and in the list
that opens, select OpenTopoMap and click Add. As a result, a topographic map of the world will be
added to your project as a new layer.

4. The next step is to merge the bands, i.e. combine the black and white bands of the satellite image
into one color image. Click Raster in the top menu and open the Miscellaneous tab → Merge.
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The Merge dialog box opens up, where you shall specify the bands you want to merge in the Input
Layers field. To do this, click on the
icon next to Input Layers, and click Add files under Multiple
selection, find the folder that contains saved image bands, and select the desired bands.

5. First, create a true-color image using B04, B03, B02 bands from the “IMG_DATA” folder of the
Sentinel archive. One of the differences between the Sentinel 2a level archive and archives of other
levels of processing is that all bands in the “IMG_DATA” folder are grouped according to spatial resolution into three folders: the first has 10 m resolution bands, the second – 20 m, and the third – 60
m. Bands B04, B03, and B02 are contained in the first folder “R10m”.
You can select three bands at once by holding down the “Shift” or “Ctrl” key on the keyboard. Then
you need to click on Open, and the selected images will download to the Multiple selection window.
It is important to select the bands in the following sequence: R (red – B04), G (green – B03), and B
(blue – B02). Therefore, you need to drag the bands in that sequence, B04, B03, B02, and click Ok.
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As a result, the number of selected bands (i.e. 3) will be displayed in the Merge window in the
Input layers line. Next, you need to check the box next to Place each input file into a separate band.
Leave the Merged field blank (in this way we create a temporary file that will not be stored on your
computer but in this project only), and click Run.

The created band combination will appear as a raster layer named “OUTPUT” in the Layers panel. Not to confuse the files, change the layer name to “4–3–2”. To do this, right-click on the layer,
select Rename layer from the menu that opens, and write a new name “4–3–2”.
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Zoom to the borders of the created raster layer, right-click on the layer name in the Layers panel
and select Zoom to Layer. If you are not satisfied with the colors in the image, you can improve it
with the buttons
located on the toolbar under Raster Toolbar. If you can't find these
buttons, it means that Raster Toolbar is not switched on in your QGIS project. To enable it, select
View → Toolbars from the top menu and check the box next to Raster Toolbar. First, select the appropriate raster layer with your left mouse button in the Layers panel, click the buttons
and experiment. The image should change. Leave the visualization you like best.

In a true-color image, all features look very similar to what a person would see from an airplane
window, i.e. all greenery appears in shades of green, open ground in shades of brown, and bodies of
water are blue.
6. Turn off the image of the created raster layer by unchecking the box next to the layer name in
the Layers panel, and find Mount Liko on the topographic map. Use the city of Errego (Ile), which
is located southwest of the area under study, the transport network, and the highlands as references
on the topographic map.
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If you managed to find a mountain on the topographic map, turn on the satellite image again in
the Layers panel and make sure that it is indeed a mountain with a forest.
Not to search for Mount Liko every time, we advise you to save this part of the map to bookmarks – you will be able to return to it easily in the future. To do this, find the New Spatial Bookmarks button
on the toolbar or use the Ctrl + B keyboard shortcut to specify the name of the
bookmark and click Save.
Return to the created true-color combination and pay attention to the color and shape of the forest
on Mount Liko. The area around the mountain looks like a mosaic of small farms, tea and eucalyptus
plantations, and forests, while the forest on the mountain appears as a holistic, non-fragmented area
that contributes to the development of biodiversity in the territory.
Check yourself
Specify a True color combination for the Landsat
8 satellite
Why do you think the vegetation in True color
combination is green?
7. Let's download now another combination, namely: B12, B8A, B04 (SWIR, Vegetation Red
Edge, Red), which is useful for the study of vegetation, because the reflectivity in SWIR is mainly due
to the moisture content in the leaves or soil. Thus, healthy vegetation with high moisture content, as
well as coastal areas will be bright green, while arid areas appear dark green, coniferous forest – deep
green, and deciduous forest – bright green.
To download a B12, B8A, B04 image, repeat the steps described in paragraph 5 above using the
Raster – Miscellaneous → Merge menu. However, select bands B12, B8A, B04, respectively (remember that it is important to keep the sequence of bands). Look for bands B12, B8A, B04 in the “R20m”
folder of the Sentinel image archive. The path to this folder looks like this:
S2A_MSIL2A_20191112T073141_N0213_R049_T37LCC_20191112T100427.SAFE → GRANULE →
L2A_T37LCC_A022926_20191112T075015 → IMG_DATA → R20m
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Rename the added raster layer to “12-8a-4” and adjust its image using
buttons.
Have you noticed the color changes in the image? All deciduous vegetation appears in shades of
bright green, while coniferous trees are dark green. Such appearance of vegetation in this combination of bands is due to the peculiarities of reflection and absorption of electromagnetic radiation.
This is described in more detail in the Fundamentals of Remote Sensing Guidance Manual, and we
will only remind you that photosynthetically active vegetation strongly absorbs red light and reflects
near-infrared radiation. Therefore, to determine the species composition of forests, the near-infrared
band is most often used, in which the crowns of deciduous trees have a much higher reflectance coefficient than those of conifers.
If you have been attentive at Geography classes, you know that the mountain area of Mozambique
is covered with tropical forests, which consist of 4-5 layers, and most plants have large evergreen
leaves because in this country, there is neither cold nor drought seasons, which normally cause falling leaves off trees. Thus, we have found out why the forest on the mountain is bright green – because
it is deciduous.
8. Forest on Mount Liko is like a “time capsule” because it is difficult to access due to the steep
slopes of the mountain. Preservation of this forest will benefit local communities that cause damage
to the surrounding forests by burning and cutting them down which in the long run may lead to deforestation of the entire region. Let's measure the forest area on Mount Liko and estimate its benefits.
You can measure the area by selecting the Measure – Measure Area button from the toolbar.
Zoom to Mount Liko and measure the area in hectares by drawing the polygon that includes the forest land. To create a polygon, left-click on the perimeter of the forest, and to complete the drawing,
right-click at the last vertex.
The resulting area will depend on the accuracy of the polygon drawing and the calculation method – Ellipsoidal or Cartesian. We advise you to experiment with different options.
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9. Having calculated the rainforest area, we can assess the value of ecosystem services it provides
to the region.
Ecosystem services are benefits to humans provided by the wild nature (material assets –
berries, mushrooms, water, wood; abstract services such as recreational, aesthetic support for
global photosynthesis, biodiversity, etc.). These services are valued in monetary units to show that
everything that nature provides us has a price. In general, it is not always easy to calculate the value
of ecosystem services, because some of them are very abstract and we cannot assess all aspects,
but let's try. According to the study by L. R. Carrasco, T. P. L. Nghiem, T. Sunderland L. P. (2014)
https://www.sciencedirect.com/science/article/pii/S000632071400295X], the average value of
ecosystem services per hectare of rainforest is $ 1,312 per year, and the maximum – up to $ 9,000 per
year (the value varies depending on the condition of the forest, etc.). .
We suggest that you calculate the value of ecosystem services for the studied forest by multiplying
the forest area by the average value of ecosystem services ($ 1,312 per year). Enter the result in the
Table below.
Check yourself
Specify the area of the forest massif (hectares).
Specify the value of forest ecosystem services
on Mount Liko ($ per year).
Scan the QR-code below to watch the video tutorial on the performance of this Task.
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3.2. Delineating the Boundary between Coniferous and
Deciduous Forests near Lisovychi Village, Kyiv Oblast
To see another type of forest and learn how to distinguish between coniferous and deciduous forests, consider the following case.
Forest management in Ukraine involves commercial development based on the economic assessment of the forests and their use as a source of wood for profit. Therefore, quite often instead of the
native species characteristic for the felled area, the most productive tree species or even alien invasive
(or simply invasive) species are planted.
Invasive species are alien species, which spread has led to threats or adverse impacts on biodiversity.
Keep in mind that not all alien species are invasive (for example, they do not include crops, most
of which are not native). Invasiveness depends on specific conditions; some alien species are not able
to spread widely in Ukraine or lose the competition to local flora and fauna. The threat is posed by
those species only that spread rapidly on their own and occupy new territories. Invasive species are a
recognized global environmental problem, but most people in Ukraine have not even heard of such
a term, so you have a chance to tell them about a very serious environmental danger!
Here are just some examples of invasive species available in Ukraine: common ragweed (Ambrosia
artemisiifolia), Sosnowsky's hogweed (Heracleum sosnowskyi), Amorpha fruticosa, Quércus rúbra,
wild olive (Elaeagnus angustifolia), Ácer negúndo, Prussian carp, Robinia pseudoacacia, Perccottus
glenii, Asclepias syriaca, Rapana venosa, sika deer (Cervus nippon), common raccoon dog (Nyctereutes procyonoides), American mink (Neogale vison). If Sosnowsky's hogweed is deemed dangerous
because it may cause burns, and all highly allergic individuals suffer from ragweed, did you guess that
acacia or deer can be dangerous for flora and fauna, and thereby for humans? In fact, this is true: invasive species have virtually no competitors in Ukraine and are spreading rapidly. At the same time,
they displace local species that are disappearing and can no longer grow and propagate themselves
in this area.
Unfortunately, invasive species are widely used in our country, and society does not understand
the harm they cause. Therefore, it is important to take measures to control the planting of new invasive species and reduce the number of those that are already growing in Ukraine. It is necessary to
apply herbicides, carry out selective felling and uprooting; it is also possible to use controlled fires
to manage such species or, in the long run, adjust vegetation by planting competing species that can
displace existing ones. For example, to plant oaks in an acacia plantation area, which in decades to
come should squeeze them out of the stand, or plant wild pears in olive groves.
Case
The forestland near Lisovychi Village (Kyiv Oblast) belongs to the Lytvynivske and Shevchenkivske Forestry Enterprise of the Dymer Forestry District. This forestland is dominated by coniferous trees, however, the forest cover in this area has transformed recently. There are practically
no reserved areas in these forestry districts and most of them are commercial forests intended for
clear-cutting. In the logged areas, new tree species are planted or self-seeded. Forestry enterprises determine independently what species to renew. Within the coniferous forest (not a native forest, planted in the 1950s and 1970s), areas of deciduous trees are gradually increasing, in particular planted
with Robinia pseudoacacia (false acacia), which is an invasive harmful species. Robinia pseudoacacia
is originated from North America; it has been planted in Ukraine since the 19th century. Plantings of
this species in the mentioned above forestland started at the beginning of the 20th century.
Task
Download Landsat-5 image taken on August 14, 2010, and Sentinel-2 image taken on July 19,
2020, of the forestland near the Lisovychi Village (Kyiv Oblast), clip the images along the map extent,
perform the classification, and identify changes in predominant forest species that occurred over 10
years.
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Task performance algorithm:
1. Using EO Browser, download B11, B08, B04 bands for the Sentinel-2 image dated July 19, 2020,
and B05, B04, B03 bands for Landsat-5 image dated August 14, 2010.
2. Open in QGIS the B11, B08, B04 band combination for Sentinel-2 and B05, B04, B03 composite
for Landsat-5.
3. Clip the raster layers along the map extent.
4. Open the Google Satellite Hybrid layer.
5. Install the dzetsaka plugin.
6. Create a polygonal vector layer, Region of interest (ROI).
7. Perform the classification.
8. Change the appearance of the classified raster layer from black-and-white to colored.
The data for this Task can be downloaded from EO Browser, or at https://drive.google.com/drive/
folders/1MUPvw74QJGmqdW4Xjme7-cETvxtao64W.
Instructions for self-guided work:
1. Open EO Browser and log in (instructions are available at the beginning of the Practice Book).
Use the search bar to find the Lisovychi Village (Kyiv Oblast) on the map. The village is located
southwest of Dymer, on the right bank of the Kyiv Cistern.

In the image search bar, select:
•

Data source – Sentinel-2;

•

Activate Advanced search and select L2A (atmospherically corrected);

•

Max.cloud coverage – 20;

•

Time range – 2020-07-01–2020-07-20;

•

Click Search.

As a result, you will get a list of images available for the selected period. Scrolling through the
list, find the image dated July 19, 2020, and display it on the screen by clicking the Visualize button.
The image will automatically be displayed in the True color combination. Take a close look at the
forestland area, and zoom to it. In Appendix A at the end of this Practice Book, you can see the
appearance of different types of land cover in satellite images. Pay special attention to the appearance
of forests.

59

Check yourself
Can you distinguish tree species in the image
using this combination? If so, based on what?
Specify the types of land cover from Appendix
A that you found in the image
Now change the combination to False color available in EO Browser list.

In this combination, vegetation is displayed in shades of red, namely: a coniferous forest is dark
red, deciduous species are light red (see Fig. below).

60

False color combination is often used to monitor vegetation but there are also other useful combinations for distinguishing forest species. We will use one of such combinations in QGIS upon
uploading the selected bands of an image. However, to do this, first, use the navigation buttons to
adjust the screen coverage so that the names of Lisovychi and Lytvynivka villages are displayed (see
Fig. below).
Important! Note that the image is automatically clipped along the map window, so before
downloading, make sure that the map covers the area of interest completely.

Download this satellite image using the Download image tool
specify the following:
•

Show logo – toggle off;

•

Image format – TIFF;

•

Image resolution – High;

•

Coordinate system – WGS 84;

•

Layers – B11, B08, B04.

. Open the Analytical tab and

Click Download and specify the path to save the archive.
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2. Repeat the steps described in paragraph 1, find and display the Landsat-5 image dated August
14, 2010. In the image search bar, select:
•

Data source – Landsat-5;

•

Max.cloud coverage – 50;

•

Time range – 2010-08-01–2010-08-20;

•

Click Search.

The Landsat images have a poor spatial resolution, which can be noticed at once from the image
quality; however, these images are important for historical analysis of changes in the area under
study. Our task is to save the Landsat-5 image bands that correspond to the downloaded B11, B08,
B04 Sentinel-2 bands because we want to download an identical combination of bands for these two
images in QGIS. This task is complicated by the fact that Landsat-5 has fewer bands and numerical
symbols in the names of Landsat-5 and Sentinel-2 bands do not match. So we suggest that you use
the band diagram from the Figure below and determine which Landsat-5 bands correspond to B11,
B08, B04 Sentinel-2 bands, and, accordingly, download these bands via Download image.
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Schematic representation of the electromagnetic spectrum bands recorded by the Earth's artificial
satellites – Sentinel 2 and Landsat 5/7/81
As a result, you will get two archives with EO Browser – one for Sentinel-2 dated July 19, 2020,
and another one for Landsat-5 dated August 14, 2010. Unzip them and start working in QGIS.
3. Open QGIS and create a new project. Add a combination of B11, B08, B04 bands for Sentinel-2
to your project. Choose Raster → Miscellaneous → Merge. Under Input Layers → , in the Multiple
selection window, click Add files, find the folder we have downloaded earlier, select B11, B08, B04
bands keeping their sequence and click Ok. Tick the box next to Place each input file into a separate
band and leave the Merged field blank (we are creating a temporary file), and click Run. Rename the
created raster layer: left-click on it in the Layers panel, select Rename Layer from the drop-down
menu, and enter a new name, “Sentinel_11-8-4”.
Repeat the steps and create a combination of B05, B04, B03 bands for the Landsat-5 image (we
hope that these are the bands that you have downloaded before; if something went wrong, return to
EO Browser and download these bands for Landsat-5). Do not forget to rename the created combination, for example to "Landsat_5-4-3".
If you have not changed the screen extent when searching for the images in EO Browser, you will
get almost identical images in terms of coverage, which we will use later. With the created combination, the deciduous forests are light green, while the coniferous forests appear in shades of dark
green; so both forest types can be easily recognized in the images. If you are not satisfied with the
raster image and want to adjust the colors, experiment with the histogram using the
buttons from the Raster Toolbar.

___________________________________________________

Remote Sensing: Analysis of Satellite Images in Geographic Information Systems / S. О. Dovgyi, S. M. Babiichuk,
T. L. Kuchma et al. Kyiv : The Junior Academy of Sciences of Ukraine, National Center, 2020. P. 49.
1
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Combination B11, B8, B04 for Sentinel-2
dated 19.07.2020

Combination B05, B04, B03 for Landsat-5
dated 14.08.2010

4. The images that we have downloaded capture a larger area than we need. So, first of all, zoom to
the forest near the Lisovychi Village using the navigation buttons and your mouse wheel. We suggest
that you change the scale to 1:14 000 in the Scale field at the bottom of QGIS work window and move
the image using the button from the toolbar so that the work window displays the forestland near
the Lisovychi Village (i.e. as in Figure below).
Important! Make sure the extents of the two images are the same. Uncheck the top layer in the
Layers, and the bottom image should fill the extent of the work window. If this is not the case, change the
coverage, experiment with the scale.

We have experimented with the scale because now we will clip the raster layers along the map
extent. Right-click on the first layer in the Layers tab and select Export and Save As from the dropdown list.
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In the window that opens, make sure that the output format is GeoTIF. Specify the name (for
example, "landsat_clip" or "sentinel_clip") and the path to the directory where you want to save the
source layer. Then specify the map projection (CRS) – WGS84. Select Map Canvas Extent under
Extent, and click Ok.

As a result, the newly created raster layer will open in your project. Repeat the clipping for the
second image. We will continue to use these files, so you can delete unclipped raster layers to avoid
confusion.
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5. Activate the Google Satellite Hybrid layer with state-of-the-art high-resolution satellite imagery to check yourself when performing classification. To do this, find the Search QMS button
on the toolbar, and a new panel will be added to the QGIS work window. In this panel, type Google
Satellite Hybrid in the search bar, select it from the list and click Add. As a result, Google map will be
added to your project as a new layer.

6. We will use in this Task the dzetsaka plugin to perform the classification. This plugin must be
downloaded via Plugins – Manage and Install Plugins ... – Not installed tab. In the search bar, start
typing the name of the plugin, and it will automatically appear in the list at the bottom of the window.
Select it from the list by left-clicking – a brief useful information about the plugin will automatically
appear. Click Install Plugin and close the dialog box.

Once installed, the dzetsaka plugin will appear in the Installed tab and will be displayed in the
Plugins menu as a separate line. This plugin is one of the simplest classification methods and is
well-suited for quick analysis in QGIS, which we will perform in this Task.
7. The classification of satellite images will be carried out automatically with this plugin. To perform the classification, however, you should create a training sample (Region of interest (ROI) that
is essential for the accuracy of classification.
ROIs are polygons used to determine the spectral characteristics of land cover classes.
To select the ROI, you should create a polygonal shapefile. From the main menu, select Layer –
Create layer – New Shapefile layer. In the window that opens, next to the File name field, click on
the
tool to find the desired folder for saving the new vector layer. Enter its name, e.g. “roi”, and
click Save.
Important! QGIS “doesn't like” Cyrillic, so use Latin characters to name files and avoid using
extra characters and spaces (this also applies to folder names where you store your files)..
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In the New Shapefile Layer dialog, select Polygon from the drop-down list under Geometry type.
Below the Geometry type field, there is another drop-down list with the names of cartographic projections. Expand the list and select WGS 84 – the same projection as we have selected before for
satellite image bands when downloading. They must match. Next, in the window to create a vector
layer, click Ok, and a new layer will open in your project.
8. Since we need to make a quick classification of forests in the images, in this example we will
identify three types of land cover only in the ROI layer:
1

Coniferous forest

2

Deciduous forest

3

Open ground

Of course, you can also find other types of land cover in the image – water bodies, overgrowing
areas of felling, buildings, etc.; for the current Task, however, this abbreviated set is quite suitable. In
other words, the set of ROIs can vary depending on our needs, and the more advanced it is, the more
detailed the classification will be.
To create this set of ROI polygons in a shapefile, you must enable vector layer editing mode. To do
this, select the layer you want to edit in the Layers (in our case, the “roi” layer) by left-clicking on it,
and click on the Toggle Editing tool . The Add Polygon Feature tool has changed from gray to
color, which means that the mode is enabled and we can start creating the first polygon by clicking
this button.
First, we shall create polygons for the areas of coniferous forest (appearing in shades of dark
green) in the Sentinel-2 image. For this purpose, zoom to the dark green area of the forest and draw
a polygon by left-clicking. If you erroneously put a vertex, you can cancel it by clicking Backspace. To
complete the digitization, right-click, type “1” in the window that appears (because we marked the
coniferous forest as “1”), and click Ok. Then, click on the Save tool . Therefore, we have created the
first polygon; to improve the classification functioning, we need to create several more such polygons
for each class. Search for other areas of coniferous forest in the Sentinel-2 image, draw several polygons, and assign the number “1” to them.
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Important! Avoid digitizing polygons along the plot boundaries not to capture pixels that belong
to another type of land cover.

Next, we will digitize areas of deciduous forest that appear light green in the image. Be careful: we
marked this type of land cover with the number “2”, so specify this number in the id field when creating
a polygon. Similarly, create polygons for other ROIs, not forgetting to change the numerical symbols
according to the specified set. In case of difficulties with the identification of features in the image, we
recommend using Google Satellite Hybrid to check your guesses. The Figure below provides tips for
you to make features’ identification easier.
Important! You can clip the images so that they don’t cover water bodies or, on the contrary, include additional features, such as settlements or buildings. In this case, simply remove or add these types of
land cover to the ROIs list and create polygons.

Coniferous forest

Deciduous forest

Open ground

To save all changes to the shapefile, click the Save tool , and then click Toggle Editing . As a
result, you will create a vector layer containing a set of data for classification (Fig. below). The next
step is the performance of classification.
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9. Go to the main menu Plugins → dzetsaka → classification dock. A new panel of the plugin will
appear which you can move to a convenient place, for example as in the Figure below.

In the panel of the dzetsaka plugin, select the raster layer to be classified from the The image to
classify field. First, we will classify the Sentinel-2 image, since we have already created the roi set
for it in the previous sub-paragraph. Accordingly, pick the roi layer in the next field (note that the
coordinate systems of these two layers, which are indicated in square brackets next to their names, are
the same – this is essential for a successful classification). In the Column name where class number is
stored field, select “id” from the created vector layer roi (classification is performed only in numerical
values). By clicking on , specify the folder for saving the classified image and enter its name, e.g.
“sentinel class”. Click on the button below , and a new dialog box opens up, where you should
select the Gaussian Mixture Model classification method from the Classifier field as this method is
the most suitable for quick classification. Upon selecting the classification method, close this dialog,
leaving the rest unchanged. To run the classification, click the Perform the classification button. As
a result, a new black-and-white raster layer will be added to your project in a few minutes, which is
the result of classification.
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10. Change the appearance of the classified raster from black-and-white to the color image
according to the values of id. To do this, right-click on the created “sentinel class” raster in the Layers
tab of your project and select Properties from the drop-down menu. In the Layer Properties window
that pops up, switch to the Symbology tab and select the Paletted / Unique values display method.
This method allows you to group pixels by their values and set the display color accordingly. Click
the Classify button to add all the unique pixel values of the raster layer. In this case, these will be the
numbers 1, 2, and 3, which correspond to the roi classes that we have created earlier. We suggest that
you change the colors for these classes. For this purpose, double left-click on the colored square in
the Color column and select a hue. We recommend using the colors in the Figure below as references
and highlighting the coniferous forest (marked “1”) with dark green, and deciduous (marked “2”)
with light green. Choose a neutral color in the shades of brown for the open ground. In the Label
column, enter the name of the class, double-click on the inscription in the field, and enter “coniferous
forest” instead of “1”, “deciduous forest” instead of “2”, and “open ground” instead of “3”. Click Ok to
apply the changes.
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11. As a result, you will get a color raster layer, in which the forest boundary should visually match
that of the Sentinel-2 image. Of course, the classification may have errors, because for a better result
you need to perform a more detailed analysis and create a wider set of roi. In this Task, we should
compare the changes in coniferous and deciduous forests that occurred during 2010 – 2020, and the
result is well-suited for this purpose.
To complete the Task, repeat the steps specified in paragraphs 7-10 for the Landsat-5 image, create
a new shapefile with the same types of land cover (roi set), perform classification, and change the
raster from black-and-white to color.
Important! The Landsat-5 image has a poor spatial resolution, so it will be more difficult to identify the features. We recommend using Google Satellite Hybrid to check the results.

Sentinel-2

Landsat-5
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Check yourself
Describe the changes that occurred in the territory of
the forestland during 2010 – 2020.
Which forest has the larger area in the image of 2020 –
coniferous or deciduous? What do you think are the causes?
Scan the QR-code below to watch the video tutorial on the performance of this Task.

3.3. Characterizing Geological Structures in the Vicinity of the
City of Al-Ula, Saudi Arabia
Case
The development of the tourism sector from scratch in Saudi Arabia underlies the Vision 2030 Program, which aims to significantly reduce the country's economic dependence on oil production. The main
tourist attraction of the country is the Winter at Tantora, an international festival of music, art, culture, and
history, which was last held from December 19, 2019, to March 7, 2020, in the city of Al-Ula.
The unique city of Al-Ula surrounded by majestic Martian-like landscapes is the main archaeological site in the north of the Arabian Peninsula and the home for many ancient civilizations. Here
are located the rocks formed of red and black sandstone of unusual shapes molded by wind and time.
Many of these rocks share some petroglyphs. It has not yet been possible to study the peculiarities
of the geological structure of this territory using various combinations. In 2008, the region was inscribed on the UNESCO World Heritage List and became the first recognized site in Saudi Arabia.
Task
Download two Sentinel-2 images of the territory of Al-Ula (Saudi Arabia) in the bands B12B08-B02, and B12-B11-B02 dated 14.02.2020.
Tantora is an ancient marker for the changing of agricultural seasons, i.e. a sundial located in Al-Ula’s old town. It has been
used by the local people not only to tell time but also to mark the changing of the seasons. At present, the local community
celebrates the festival, which symbolizes the beginning of the winter season, as well as the return of agricultural activity in
the region. Over the years, it has become a popular tradition that symbolizes development and progress.
Al-Ula county is located 300 km north of Medina – a place of extraordinary human and natural heritage. The Wadi AlQura (the Valley of Villages) is a lush oasis valley that runs through Al-Ula, sheltered by sandstone cliffs, that created
ideal conditions for several civilizations to flourish. In ancient times, the Dedanites, Lihyanites, and Nabataeans all
built their cities here. The Al-Ula region has always been an important trading route used from at least the first
millennium BC. Al-Ula, positioned on the ancient Incense Route between Southern Arabia and Egypt, became a
commercial and cultural center. Its oases and cities were important stopping-points for traders of frankincense,
myrrh, and other precious commodities.
You can visit this region together with Anton Ptushkin. To watch his blog about Saudi Arabia, go at https://youtu.
be/ea5uxRmRe8Y.
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Task performance algorithm:
•

enable the QuickMapServices plugin and download the ESRI Boundaries & Places map;

•

merge B04, B03, B02 bands (a true-color combination) for each image, and combine two images into one raster layer;

•

merge B12, B11, B02 bands (Geology combination) for each image, and combine two images
into one raster layer;

•

save the area in the map to bookmarks – Al-Ula Valley;

•

download the AFR CGMW BRGM 10M Geologic Units map from the OneGeology portal to
your project via URL as a WFS shapefile.

Instructions for self-guided work:
1. Download the data for the Task from https://drive.google.com/drive/folders/1Q7W-cWfD1zqR7WOjkPOxOoME64aefyd or from EO Browser. In this Task, we will use two Sentinel-2
images. All jpg image feeds are located in the “IMG_DATA” subfolder. The path to this subfolder we
have already specified in the previous tasks; it may look like this: S2B_MSIL1C_20200214T075959_
N0209_R035_T37RCK_20200214T100110 → S2B_MSIL1C_20200214T075959_N0209_R035_
T37RCK_20200214T100110.SAFE → GRANULE → L1C_T37RCK_A015362_20200214T080655 →
IMG_DATA.
2. Open QGIS application and create a new project. Make sure that the Browser and the Layers
panels are open in QGIS. If you do not see them, select View → Panels from the top menu and tick
the boxes next to Browser, Layers, and Spatial Bookmarks. Also, download the ESRI Boundaries &
Places map via the QuickMapServices module; if this module is missing, use the instructions from
Task 3.1 to install it. Find
Search QMS on the toolbar and turn on the search field by clicking on
this button, start typing ESRI in the search field. Various maps will appear automatically in the list
below. Select and add ESRI Boundaries & Places from the list.

3. First, create a true-color combination for the two downloaded images to see what the area looks
like with the “human eye”. In this Task, we use Sentinel-2 images, and a true-color combination of
bands for any Sentinel-2 images is as follows: B04, B03, and B02.
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Let's create a combination of B04, B03, B02 bands for each image (it is not essential what image
will be processed first). Select Raster → Miscellaneous → Merge. In the Input Layer line → , in
the Multiple selection window, click Add files and select B04, B03, B02 bands (all image bands are
stored in the “IMG_DATA” folder, the path thereto is described in the first paragraph) maintaining the
sequence, and Ok. Next, you need to tick the box next to Place each input file into a separate band,
and leave the Merged field blank. In this way, we create a temporary file that is not stored on your
computer but is available in this project only and click Run. Zoom to the borders of the created raster
layer, right-click on the layer name in the Layers panel, and select Zoom to Layer from the dropdown box.
Repeat the steps and create the same combination for the second image.

S2B_MSIL1C_20200214T075959_N0209_
R035_T37RCK_20200214T100110

S2B_MSIL1C_20200214T075959_N0209_
R035_T37RDK_20200214T100110

Check yourself
Have you noticed that although the combination is
the same, it is not displayed similarly in the two images?
Why do you think?
4. The next step is to merge two images into one. This can be done through the main menu Raster – Miscellaneous – Merge. In the Input Layers field, select the items you want to merge, namely
two files called “OUTPUT” with created true-color combinations. Leave the Merged field blank. In
this way, we create a temporary file that is not stored on your computer but is available in this project
only, click Run.
Important! This time, we do not check the box next to Place each input file into a separate
band to get a fully merged raster layer.
It takes some time to merge two raster layers, so don't panic, just wait.
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We recommend renaming the created raster, for example to “merge_4-3-2”, and deleting the
previously created combinations. To perform all these operations, left-click on a layer in the Layers
panel, select Rename Layer from the drop-down menu; to delete, click Remove Layer.
Take a look at the merged raster layer. Do you notice any color changes in the image? Now the
color has become homogeneous with smooth and seamless transition between the images. To remove the black background appearing to the left of the image border, double-click on the name of
the merged image in Layers. The Layer Properties menu will appear. Go to the Transparency tab and
write “0” in the Additional no data value field, and click Ok.
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In a true-color satellite image, the desert is displayed in different shades of brown and white, and
therefore does not look very impressive. Let's try to display it differently.
5. We will merge the bands for images by choosing another combination, namely "Geology" (B12,
B11, B02). Each type of rock formations reflects short-wavelength infrared light differently. We can
see it by comparing the reflected SWIR light. This combination uses B12 (SWIR) band to delineate
different types of rocks containing anionic groups such as Al-OH, Mg-OH, Fe-OH, Si-OH, carbonates, ammonium and sulfates. Therefore, again, we should first merge the bands for each image separately, this time for B12, B11, B02 bands, and then combine them into one raster layer. To do this,
simply repeat the instructions given in paragraphs 3-4; just remember that you need to select B12,
B11, B02 bands for the combination. You can start merging bands with any image, since changing the
order does not change the result.

В04, В03, В02 combination

B12, B11, B02 combination

Rename the created merged raster layer to “merge_12-11-2” and remove the black background.
Thus, we get an image displayed in completely different colors, where the desert seems to have blossomed. Thee B12, B11, B02 combination simplifies to a great extent the visual interpretation of geological units because the colors mark different minerals. Yellow/brown areas are used for goethite,
dark green – chlorite, light green – clay, and purple – sulfides. Cleavages appearing in satellite images
mark potential mineral ores or subsurface deposits. Such surveys of the area using satellite images
can help to find potential deposits before a planned on-site inspection.
6. Examine the images in more detail and compare the created true-color and Geology combinations. Using the ESRI Boundaries & Places map given above, find Al-Ula Valley. Pay attention to the
order of the layers display. The ESRI Boundaries & Places map should be on top of all other layers,
i.e. the first in the list. If it is displayed differently, move it – first, select it with your left mouse button
in the list of layers and drag it to the top. Now the inscriptions of cities and highways are displayed
in satellite images.
Use the navigation buttons from the toolbar to zoom to Al-Ula Valley and save this map area to
bookmarks. Find the New Spatial Bookmarks button on the toolbar, or use Ctrl + B to specify a
bookmark name, such as Al-Ula, and click Save.
Check yourself
Using the Geology combination, determine the
composition of rock formations in Al-Ula valley –
the cradle of many extinct civilizations.
Analyze based on color which rock formations
are the most common in the merged image in the
Geology combination
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7. The last assignment in this Task will be to add OneGeology map to this QGIS project as a
WFS-shapefile via URL (Uniform Resource Locator).
WFS (Web Feature Service) is a standard protocol that is the technological basis for remote access
to the cartographic materials database. The WFS query defines a layer(s), a map area that can be
displayed as a layer in the QGIS project as vector spatial data.
To download the OneGeology map, you must first copy the URL link from OneGeologyPortal.
Therefore, go to http://portal.onegeology.org/OnegeologyGlobal/ or just type OneGeology in the
search bar and follow one of the first links. Using the navigation buttons, zoom to the Arabian
Peninsula and open the Datasets tab from the right sidebar. Tick the box next to CGMW-BRGM
1:10M Geological map of Africa only, because this map contains data about the area under study.
Click the arrow
next to the map name, and copy the Service URL link by clicking
in the tab
that opens.

OneGeology map resource interface (URL: http://portal.onegeology.org/OnegeologyGlobal/).
Copying the URL link http://mapsref.brgm.fr/wxs/1GG/IGC35_CGMW_BRGM_Africa_Geology
from the OneGeology portal.
Return to QGIS to add the OneGeology map to your project. Select Layer – Add Layer – Add
WFS Layer from the main menu, and click the New button in the window that opens to add a new
WFS layer. In the new dialog box, type “Geology” in the Name field, specify the URL-service that
we have copied from the OneGeology site in the URL field (see Figure below), and click OK. Return
to the WFS dialog box and click the Connect button. The box below will update and display all the
maps that have been downloaded to this created URL connection. Select AFR CGMW BRGM 10M
Geologic Units from the list and click Add.
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8. The downloaded map will appear in the list of layers in your project. Any map that is downloaded via WFS will be displayed as a shapefile in the list of layers. If the shapefile consists of polygons,
they all will be displayed in the same color automatically after downloading. To change the display of
the downloaded layer, double-click with your left mouse button on its name, and change the display
mode from Single Symbol to Categorized in the Layer Properties dialog box under the Symbology
tab. In the Value field, select the name of the column containing data for building a map (in our case,
select "STRATI"), and click the Classify button to download all the values from the column we selected in Value. Click Ok. The polygons will be displayed in different colors (according to the parameters
we specified above).
In the same dialog box, change the transparency of the displayed layer: expand Layer Rendering
and drag the slider or change the numeric value to “40%” in the Opacity field.
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Pay attention to the order of the layers display. The map “AFR CGMW BRGM 10M Geologic
Units” should display on top of all other layers, i.e. be the first in the list. If it is not the case, move
it – select it with your left mouse button from the list of layers and drag it to the top.
9. Using the Identify Features button, determine the time when the geological structures within the area under study were formed (combined satellite image). To do this, select the downloaded
map “CGMW-BRGM 1:10M Geological map of Africa” from the list of layers with your left mouse
button, find the button on the toolbar (under Attribute Toolbar). If this button is missing, enable
it by right-clicking on the toolbar and checking the box next to Attribute Toolbar). Click , hover
over the polygon you are interested in and select it with your left mouse button. All the information
about the selected polygon will appear in the Identify Results sidebar. Pay attention to the “STRATI”
field, where the era or period from the stratigraphic table is shown when this territory was formed
(remember what you have learned at the Geography classes), as well as the “LITHO” field, where the
origin of the sediments is indicated.
Important! If you have selected a layer other than the required source of information, the button
will either not work or will provide information about another layer that is selected from the list of
layers.

Using the data from the “AFR CGMW BRGM 10M Geologic Units” map and the Identify Result
table, analyze the relationship, if any, between the color changes in the satellite image in the Geology
combination and the boundaries of the geological units highlighted on the map.
Check yourself
Specify the names of all stratigraphic periods
(“STRATI” field) that are identified within the
merged satellite image. Indicate which period is
the oldest and which is the youngest.
Write how many geological units does the study
area cover (merged satellite image).
Using the “LITHO” field, determine the predominant types of sediments in the area under study.
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A few years ago, listening to music was banned in Saudi Arabia, and now citizens and visitors can
enjoy the large Maraya Concert Hall (means “mirror” in Arabic) that was built in the Al-Ula Valley
and earned the Guinness World Records title. It is the largest mirror-clad building in the world. Rocks
and endless sands are reflected on the walls of the building, creating a mirage effect. According to the
author's plan, this design makes the hall an “architectural extension of the environment surrounding it”.
Check yourself
What are the characteristic features, in your
opinion, according to which you can you find the
Maraya Concert Hall on a satellite image?

Location of the Concert Hall on the satellite
image [URL: http://mapsref.brgm.fr/wxs/1GG/
IGC35_CGMW_BRGM_Africa_Geolog]

The Concert Hall in the image
[URL: https://experiencealulages/default.aspx]

Scan the QR-code below to watch the video tutorial on the performance of this Task.
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4. Visualization of Images on a Digital Elevation Model
4.1. Creating a Digital Elevation Model of Mount Hoverla
Case
Mount Hoverla at 2,061 meters, is the highest mountain in Ukraine. It is located in the mountainous
region of Chornohora, on the border of Yaremche City Council (Ivano-Frankivsk Oblast) and
Rakhivskyi District (Zakarpattia Oblast), within the reserved areas: the Carpathian Biosphere
Reserve (Transcarpathia) and the Carpathian National Nature Park (Ivano-Frankivsk Oblast). The
slopes of the Mount are covered with beech and spruce forests. At 1,500 meters, the subalpine belt of
pastures (known as meadows) begins. The first tourist route for climbing to the top was opened in
1880. In winter, climbing Hoverla is assigned category 1B.1 One of the most common climbing routes
starts from the Zaroslyak tourist complex (climbing time – 3-4 hours).
Task
Create a 3D model of Hoverla Mount and part of the Chornohora ridge, determine the steepness
of the tourist route, the differences in height on the climbing trail from the Zarosliak tourist complex.
Task performance algorithm:
1. Download the SRTM digital elevation model of the Carpathians (Chornohora ridge).
2. Based on the elevation model, create a map of the steepness of the slopes and choose the flattest
trail from the various routes to Hoverla Mount.
3. Create a 3D model of Hoverla Mt. based on the SRTM digital elevation model.
Instructions for self-guided work:
1. Download the SRTM digital elevation model of the area under study
from
SRTM
Tile
Grabber
(https://dwtkns.com/srtm)
geoportal
or
at
https://drive.google.com/drive/folders/1pb5YCqcUA_UcaV8l_FytlviVLvGtQ_xs (at this link, you
can find data to this Practice Book).
SRTM, Shuttle Radar Topography Mission, is an international research project to create a digital
elevation model of the Earth's land surfaces.
In the map window of the geoportal, you can see that the territory is divided into zones represented by squares (tiles). Using the navigation tools, select a square that covers the territory of the
Ukrainian Carpathians. Once you click on it, a window for downloading the tile srtm_41_03 shall
appear. Click on Download GeoTiff .

___________________________________________________
1

URL: https://uk.wikipedia.org/wiki/Говерла.
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SRTM Tile Grabber web portal interface (https://dwtkns.com/srtm).
2. Unzip the downloaded file and add it to your QGIS project.
3. Add an OpenStreetMap to your project (from XYZ Tiles under Browser) and find Hoverla
Mount on the map, as well as the Zarosliak tourist complex and the Skopeska Meadow. Zoom to the
map to display these three locations at the same time.

4. Clip the SRTM raster along the map extent by right-clicking on the layer under Layers, and
select Export, Save As from the drop-down list.
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In the window that opens, check the input format (should be GeoTIF), specify the name (e.g.
“srtm_goverla”) and the path to the directory where you want to save the input layer. Set the map
projection (CRS): WGS84 / UTM Zone 35N (step-by-step instructions for selecting the required
projection are given in Section 2.2 (4)). Select Map Canvas Extent under Extent, and click Ok.

Once you hit the Ok button, a new raster layer will open in the project. We will use this file to
speed things up.
5. Adjust the color display of terrain for better visualization of height differences. Double-click on
the "srtm_goverla" under Layers to open the Properties window of the terrain layer. Switch to the
Symbology tab and select the following settings from the dialog box:
•

Render type – Singleband presudocolor;

•

Color ramp – Select a scale from blue to yellow.

Click Ок.
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As a result, the peaks will be displayed in yellow and the lowlands in blue.
6. Make the elevation layer semi-transparent so that you can see also features on the map. Open
the layer properties window again (double-click on the “srtm_goverla” layer under Layers), switch to
the Transparency tab in the Properties window, and set the transparency level to 50%.

You should get the same output as in the Figure below.
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Note that the “srtm_41_03” input layer must be disabled, it can be deleted from the project (it will
not be used anymore in this Task). The OpenStreetMap and “srtm_goverla’ layers must be enabled.
You can see from the map that the lowest parts of the area under study are located along the riverbeds. The Chornohora ridge is also well distinguished.
Check yourself
What other peaks of Chornohora ridge, besides
Hoverla, can be identified on the map?
7. Another convenient way to visualize the elevation of the terrain is the Hillshade method, i.e.
mapping the terrain in shades of grey using sunlight and shadow to create a 3D-looking image. This
method allows you to enhance the topography of the landscape and is used mainly with overlapping
a semi-transparent raster layer of elevations. To create a Hillshade layer, click on the menu items
Raster – Analysis – Hillshade.
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In the window that opens, specify “srtm_goverla” in the Input layer field, and set the name (e.g.
“hillshade”) and the path to the folder where the output layer will be stored in the hillshade field, and
click Run.

The created layer will open in your project. It is necessary to drag it with your mouse cursor to
place it under the srtm_goverla layer. Next, open the properties of the hillshade layer and adjust its
transparency – 50% (as described in paragraph 6 of this Task). The result should look like in the
Figure below.
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8. Another useful thing to know about the terrain is how steep it is. Therefore, we will now create
a slope map. This will help to identify the flat and steep terrain, and therefore, choose an easier way
to climb to the top. To do this, click on the menu items Raster – Analysis – Slope.

In the window that opens, specify “srtm_goverla”, the name (for example, “slope”), and the path to
the source layer under Input layer.
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9. Adjust the display of the slope map. To do this, open the layer properties window (double-click
on the layer in the Layers tab) and select Properties. Specify the following in the Symbology tab:
•

Render type – Singleband presudocolor;

•

Color ramp – select a scale with a red color gradation;

•

Mode – quantile;

•

Сlasses – 5.

To finish, click Ok.

Now you see how the slope changes as you approach the summit from the side of the Zarosliak
tourist complex – steepness is expressed in degrees (it is lower on gentle slopes and higher on steep
slopes). You can review the slope values using the Identify results tool.
Check yourself
Analyze the slope map and determine
whether the steepness of the slopes increases as
we approach the summit of Hoverla.
10. Take a look again at the OpenStreetMap map, disable all other layers in the Layers tab and
position the map so that you can see the routes to Hoverla Mount from the Zarosliak tourist complex. The climbing routes appear as dotted lines on the map, so you can see four main trails that
are numbered in the Figure below.
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According to the map, route 2 is the shortest one. Now enable the slope layer and analyze which
trail will be the easiest, with the gentlest slope (for better visualization, you can increase the transparency of the “slope” layer to 30%). With this visualization, it becomes clear that route 1, which passes
through Mala Hoverla Mount, is the flattest one, and therefore, the easier albeit longer trail. It has a
sharp rise in front of Mala Hoverla Mount, almost in the middle of the route.
\

Route 1 is called Green (the easiest), and route 2 is called Blue (the most difficult). These routes
are marked accordingly on the scheme of climbing routes to Hoverla Mount.
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Scheme of marked routes to Hoverla Mount
(URL: https://pohod-v-gory.com/маршруты-на-говерлу).
11. Let’s create now a 3D-visualization of the terrain around Hoverla Mount. Leave only the
“srtm_goverla” layer (transparency 50%) and “OpenStreetMap” enabled in the project, so that the
height and marks on the map can be seen at the same time. Click the View menu item and select New
3D Map View.

It is not possible to create a 3D visualization for a project in a geographic coordinate system –
you need to change the map projection to WGS 84 zone 35N (projected coordinate system). To do
this, click on the Project, Properties menu items and in the window that appears, open the CRS tab,
enter “WGS 84 zone 35N” in the Filter field, select this projection from the Coordinate Reference
System window, and click Ok.
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In the window that opens, click the Configure tool

.

Switch to Terrain in the window that appears, select DEM (which stands for digital elevation
model) in the Type field, specify the “srtm_goverla” layer under Elevation, and select 2 in the Vertical Scale field (this will increase the effect of the height difference for better visualization), and click
Ok.
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You can now rotate the 3D model by holding down the mouse wheel. Move the wheel to zoom
in and view the 3D model from different angles. Note that active (enabled in the project) layers only
will display, so you can add different vector and raster data to your project to display them in the 3D
model. You can also enlarge the 3D visualization window by stretching the corners of the window
with your mouse cursor.

12. Select the angle you like, click the Save as image tool
as the image.
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, and save the selected 3D model angle

Scan the QR-code below to watch the video tutorial on the performance of this Task.

4.2. Analyzing Terrain to Determine the Growing Conditions of
Rare Orchid Species in the Carpathians
Terrain (relief) is a set of forms of the earth's surface in different stages of development and in a
complex interrelation with each other and the environment (Wikipedia). Terrain affects the microclimate of the region, which in turn affects the distribution of heat, light, water and other resources
available to plants growing in the area. Therefore, analysis of terrain is essential for the distribution
and growth studies, in particular of rare plant species, and assessment of existing risks and threats to
their habitats.
Task
In this Task, we will analyze the terrain of the places where orchids grow naturally in the Carpathians: the altitudes and slopes (North-facing, South-facing, or other).
The orchid family is one of the largest groups of plants on the planet. Representatives of this family
can be found on every continent except Antarctica; they grow in rainforests, savannas and steppes,
hot lowlands, cold mountainous areas, at altitudes of up to 5,000 m. However, the greatest number
of Orchidaceae (orchid family) species can be found in tropical and subtropical zones of East Asia,
as well as in Central and South America. Approximately 70 species of orchids grow in Ukraine, and
most of them are listed in the Red Data Book (Wikipedia).
We will find the places where orchids naturally grow with iNaturalist social network, which can be
accessed via its website or from its mobile application. On iNaturalist, users can identify the species
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from a photo of a plant, animal, fungus, or other organisms with the help of the automated species
identification tool and community of naturalists, and save the location in the database. iNaturalist
provides valuable data for environmental specialists that help to understand the threats and justify
conservation efforts, e.g. the creation of protected areas in the habitats of species.
Task performance algorithm:
1. Download data on the places where orchids naturally grow in the Carpathians using iNaturalist
platform.
2. Characterize the terrain (altitude, slope, and aspect) in places where orchids grow.
3. Describe the conditions of growth (ecological niche) of the Orchidaceae in terms of terrain.
Instructions for self-guided work:
1. Go to https://www.inaturalist.org/ and sign up. Registration is very simple: you need to specify
your e-mail, invent and specify the username, password, enter the password again in the field below
(password confirmation), check “I'm not a robot”, agree to other terms of use of the service, as in the
Figure below.

iNaturalist interface (URL: https://www.inaturalist.org/)
2. Find the nearest natural area on the map and review the species that were identified and photographed in this area. To do this, click on the Explore menu, and in the window that appears, enter
the name of the natural area near you in the Location field (the name of the forest, park, tract, etc.),
such as “Holosiivskyi, Kyiv, Ukraine”.
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iNaturalist website interface: Search results for “Holosiivskyi, Kyiv, Ukraine”
(URL: https://www.inaturalist.org/)
The search area will be highlighted in red on the map, and a list of species photographed and saved
by community members will be displayed on the right side of the screen. If you have already created
an account before, the Observation tab will appear. If this is the case, check and remove the filter by
clicking on the Filter menu item at the top of the window.

In the Show module of the window that pops up, tick the box next to the Checked item – verified
results only will be displayed in the search results. Next click Refresh search.

iNaturalist website interface: Search results for verified wildlife species
(URL: https://www.inaturalist.org/)
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Check yourself
Specify five types of species observed in the
natural area that is nearest to you (e.g., forest,
park, coast)
3. We will find now the area of the Carpathians on the map and search for the places where orchids
grow in the database. To do this, enter Orchidaceae (this is the scientific term denoting plants of the
orchid family) in the Species search bar, and pick this family from the drop-down list. Next, enter Rakhivskyi District (select from the list) in the Location field, and click Go.

iNaturalist website interface: Search results for the Orchidaceae species in Rakhivskyi District,
Zakarpattia Oblast, Ukraine (URL: https://www.inaturalist.org/)
The search area enclosed in a square with an orange outline, as well as a list of recorded observations will display on the map. By clicking on the Species tab, you can review in more detail all the
orchid species found in the selected area. Currently, there are 10 such species in the database (the
number of species and observations may change over time).

iNaturalist site interface: Search results for the Orchidaceae species in Rakhivskyi District, Ukraine
(URL: https://www.inaturalist.org/)
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If the list of observations is missing, check the Filter menu item – it should be disabled to avoid
searching among your observations only (described in more detail in paragraph 2 above).
Check yourself
Specify the number of observations (i.e. places
where orchids were found in the Carpathians)
that are displayed on iNaturalist.
4. We will save these found places where orchids grow as a database that can be opened in QGIS
as a vector layer of vertices. To do this, go to the Filters tab, and in the dialog that opens, set the following: tick the box next to Verifiable under Show, select the plant icon under Categories, and select
Any under Date Observed. Then click the Download tool.

iNaturalist website interface: Search results for the Orchidaceae species in Rakhivskyi District,
Ukraine, verified wildlife species (URL: https://www.inaturalist.org/)
In the window that opens, you can check whether the data was selected correctly by scrolling
down the page and viewing item 2, Preview. The data you want to download should appear in this
list.

iNaturalist website interface: Search results for the Orchidaceae species in Rakhivskyi District,
Ukraine, verified wildlife species (URL: https://www.inaturalist.org/)
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Scroll down and click Create Export.

iNaturalist website interface: Exporting search results for the Orchidaceae species in Rakhivskyi
District, Ukraine (URL: https://www.inaturalist.org/)

As a result, you will get a table generated according to the specified sampling criteria as a separate
file that must be downloaded by clicking on the Download tool.

iNaturalist website interface: Export results for the Orchidaceae species in Rakhivskyi District,
Ukraine (URL: https://www.inaturalist.org/)
Once you unzip the downloaded file, you will get a table containing data of found orchids in scv
format, which can be opened with QGIS. You can also download this “observations-112284.csv”
file at https://drive.google.com/drive/folders/1FqrxnbmNwKjBG1T1zNxfHd66hMWovdAm, along
with materials for this Task.
5. Open QGIS, create a new project and unzip the downloaded file.
6. Next, open the table downloaded from the iNaturalist site, which contains data of found places
where orchids grow as a vector point layer. To do this, select from the Layer menu: Add Layer – Add
Delimited Text Layer.
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In the window that opens, specify the downloaded file containing the data of orchid locations in
the File name field; select “scv” under File format; expand the Geometry Definition tab and select
Point coordinates, X field – longitude (it is in this field that the longitude coordinate is stored in the
downloaded table), Y field – latitude; and specify “WGS 84” in the Geometry CRS field (map projection). Click Add.

As a result, you will get a map of places where orchids grow.
7. Open the SRTM raster terrain layer of the Carpathians (we have downloaded this layer in Task 4.1;
instructions for creating a layer are described in pp. 1-2). Make sure that the point layer is located above the
terrain layer; if necessary, change the placement of the point layer in Layers. You can also download this
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layer from https://drive.google.com/drive/folders/1FqrxnbmNwKjBG1T1zNxfHd66hMWovdAm,
along with materials for this Task.

8. Create an aspect map based on the SRTM terrain layer. To do this, open the Raster menu –
Analysis – Aspect.

In the window that appears, specify Input layer – SRTM_41_03 (downloaded terrain layer), and
click Run.
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As a result, an aspect map will be created, where you can see the part of the world the slope faces
(the East, West, South, or North).
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Check yourself
Specify in which part of the aspect map the
riverbed is located in the Figure above.
What are the signs of the riverbed on the aspect
map?
9. Now we will review the values of altitudes and aspects at the places where the orchids were
found. To do this, we will use the Zonal statistics tool. As far as this tool can only be used for a polygonal layer and not a point one, first, we will create a vector polygon layer from the vector point layer
using the Buffer tool. So, open the Vector menu – Geoprocessing Tools – Buffer.

In the window that appears, specify “observations” vector point layer under Input layer and the
minimum value “0.0001” (degrees) in the Distance field, click Run.

A new vector polygon layer should open in the project.
10. Type “zonal statistics” in the search bar under Processing Toolbox and double-click on the
appropriate tool to open it.
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In the dialog that pops up, select Output (aspect layer) in the Raster layer field, pick Buffered
under Vector layer, and “aspect_” in the Output column prefix field (to distinguish easily this field
in the Attribute Table). Next, expand the Statistics to calculate tab and select Mean, click Ok, and
then click Run.

11. Do not close the Zonal Statistics dialogue, and calculate the values of the height at each point
where orchids were found. For this purpose, select srtm_41_03 under Raster layer, pick Buffered in
the Vector layer field, and select “height_” (the field in which the height values from the terrain layer
will be saved) under Output column prefix. Next, expand the Statistics to calculate tab, select Mean,
click Ok, and click Run.
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12. Open the Attribute Table of the buffered layer for which the height and aspect values were determined, drag the slider at the bottom of the Table to see the last columns (these two new columns,
“aspect_mean” and “height_mean”, should appear at the end of the Table).
13. Therefore, to understand at what altitude and on what slopes orchids were found, we will build
histograms for these values. To do this, switch to Vector Layer Histogram in the Processing Toolbox
search bar, and double-click on the corresponding tool to open it. In the dialog box that appears, select a vector buffered layer with height and aspect values in the Input layer field, pick “height_mean”
under Attribute and type 20 in the number of bins field, and click Run.
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14. As a result, a link to the histogram will appear in the right-hand Results Viewer pane. Double
click on it to open.

The graph that opens shows the height values on the x-axis, and the number of recorded observations at the corresponding height on the y-axis.
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As can be seen from the graph, the largest number of observations (encounters of orchids) was
recorded at the altitudes from 800 to 1,100 m.
15. We will create now a histogram for the aspect values. Click the Vector layer histogram tool
again. In the dialog box that appears, select the vector buffered layer with the height and aspect values
again in the Input layer field, pick “aspect_mean” in the Attribute field, enter 10 in the Number of
bins field, and click Run.

16. Open the created histogram by double-clicking on the top Histogram line in the Results Viewer panel. A graph should open with the aspect values of the slopes (in degrees) displayed on x-axis,
and the number of orchid encounters on such slopes on y-axis.

The graph shows that the largest number of orchid encounters was recorded on the slopes with
the aspects of 100-150 degrees, which according to the Figure below corresponds to the slopes facing
the East and South-East.
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17. Thus, we can conclude that the orchid encounters in the Carpathians were mostly recorded at
a height of 800-1,100 m, on the slopes facing East and South-East.
Scan the QR-code below to watch the video tutorial on the performance of this Task.
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5. Indexed Images: Vegetation Index for Monitoring the
Dynamics of Vegetation
5.1. Regional Assessment of the Crimean Peninsula Vegetation
Using MODIS Data
Case
The agriculture sector on the temporarily occupied Crimean Peninsula is constantly exposed to both
anthropogenic and natural impacts. The effects of the drought are exacerbated by the inability of the
occupying authorities to solve the problem of sufficient water supply on the Peninsula. “Agriculture,
especially in the northern part of Crimea, is actually killed. Since the Dnipro water is not supplied,
citizens have built hundreds of artesian wells and are trying to water the fields with mineral water. As
a result, the groundwater level decreased by about 17 meters. Soil becomes salinized and unsuitable
for agriculture,” explained Mustafa Dzhemiliev, the Commissioner of the President of Ukraine for the
Crimean Tatar people.1
The Ministry of Temporarily Occupied Territories and Internally Displaced Persons of Ukraine
studied the condition of vegetation on the Crimean Peninsula in 2016 and 2018. You can get acquainted with the results of these studies in more detail on the Ministry’s official website: https://
mtot.gov.ua/na-tymchasovo-okupovanij-terytoriyi-ar-krym-zafiksovano-nachnezmenshennyaroslynnosti.
Task
To map the changes in the Normalized Difference Vegetation Index on the Crimean Peninsula as
of June 1, 2010, 2015, and 2020, using MODIS satellite images.
Task performance algorithm:
1. Download satellite images as of the following dates: 01.06.2010, 01.06.2015, and 01.06.2020.
2. Create a layer of Normalized Difference Vegetation Index (NDVI) for these dates.
3. Visualize the difference between NDVI for 2015 and 2020.
Instructions for self-guided work:
1. Open EO Browser service: https://apps.sentinel-hub.com/eo-browser.
2. Log in to the service from your account.
3. In the search box, enter “Crimea” and click on the highlighted line to zoom to the area.

___________________________________________________
1
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URL: ru.krymr.com. https://ru.krymr.com/a/news-djemilevdeokkupacyja-kryma/29901555.html

4. Set the following:
•
•

Data source – MODIS;
Time range: from 01.06.2010 to 06.06.2010.

Select an image dated June 1, 2010 (there are two of them in the search results list, you can choose
any) by clicking on Visualize.

5. Download the bands required for the NDVI display.
NDVI is the Normalized Difference Vegetation Index (NDVI), first used in 1979.
NDVI = (NIR – Red) / (NIR + Red),
where NIR is the near infrared region of the spectrum; Red – visible red region of the spectrum.
The NDVI index depends on the activity of biomass and chlorophyll and provides data ranging
from −1 to +1. Red waves are absorbed by chlorophyll only therefore, the more red light absorbed,
the more active chlorophyll in the leaves of plants.
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Plant cells are filled with water and function as a mirror for the infrared waves. When the osmotic
pressure1 is high, the plant reflects most of the infrared spectrum. Thus, the more infrared spectrum
the plant reflects, the more biomass and the better the health of the plant.
In MODIS:
NIR = B2 (0.841–0.876 μm);
Red = B1 (0.62–0.67 μm).
Use the tool
to download the required image.
In the download settings panel, select:
•

Analytical tab;

•

Image format: TIFF (32-bit float);

•

Image resolution (Spatial resolution): HIGH;

•

Coordinate system: WGS 84 (EPSG 4326);

•

Layers: B01 and B02.

Once you have selected the required settings, click Download. An archive document with satellite
images
will be downloaded. Unzip it.
Create a “MODIS” folder and save to this folder the unzipped satellite images.
6. Open B01 and B02 bands in QGIS:
•

open

•

use the Open Data Source Manager tool

(Start → Programs → QGIS 3.16 → QGIS 3.16 with GRASS);
.

In the Raster tab, specify the path to the images in the MODIS folder → Add.

___________________________________________________

Osmotic pressure is a phenomenon caused by the presence of a semi-permeable membrane that separates solutions.
For living cells, the cytoplasmic membrane functions as the semi-permeable membrane, creating the osmotic pressure.
URL: https://stemua.science/Research_works/Osmotic-pressure-cells.
1
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As a result, you will see bands in the Layers panel
.
Rename the bands, leaving only the band names B01 and B02 (right-click on the layer name in the
Layers → Properties → Source → Layer name → B02 / B01 → Ok).

7. Create the NDVI layer.
To create a layer of Normalized Difference Vegetation Index, use the Raster Calculator tool. Click
the Raster tab in the menu bar. This tab contains the Raster Calculator tool.
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In the Raster Calculator Expression dialog, enter the NDVI formula, substituting the names of
the corresponding layers from the MODIS.
Important! The formula should be entered with the mouse cursor only, by clicking on the operation symbols and the names of the layers (the keyboard should not be used for this purpose to avoid
incorrect processing).
where NIR is B2, Red is B1.

NDVI = (NIR – Red) / (NIR + Red),

In the Output layers, specify the name of the layer, “NDVI_2010”, and the path for saving the
created layer (“MODIS” folder).

As a result, a new layer will be created and displayed in the Layers tab.
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8. Since the layer is displayed in shades of gray, you need to change the shades of gray to green for
better perception. To do this, select for the NDVI 2010 layer → Properties → Symbology, and set the
following parameters:
Render type: Singleband pseudocolor;
Interpretation: Linear (For a continuous color scale);
Color ramp: Greens;
Classes: 10;
Mode: Equal interval.
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As a result, the NDVI layer will be displayed in shades of green.

9. Using the same algorithm, create the Normalized Difference Vegetation Index layers for
01.06.2015 and 01.06.2020 (name the layers “NDVI_2015” and “NDVI_2020”, respectively).
Leave the NDVI layers for 2010, 2015, and 2020 in your project only, and delete the rest of the
layers, as we will not use them.

10. Visually compare the Normalized Difference Vegetation Index values in 2010 and 2020 by
unchecking each of the layers in the Layers tab. You can also use the mouse cursor to zoom in and
out of a certain area.
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Check yourself
Track the differences in NDVI between the
areas located at various altitudes above sea level in
2020, 2015, and 2010.
Compare the NDVI values on the land and in
the waters of the Black Sea and the Sea of Azov in
2020, 2015, and 2010.
11. Visualize the differences between the NDVI values in 2015 and 2020 on the map.
Important! Comparing values for the same date in different years is not a fully representative
sample for research. It is better to compare the average values (monthly, seasonal or annual) to exclude
random, single, force majeure factors that occurred on a chosen day and may “blur” or “distort” the
research results.
Using the Raster Calculator, find the difference in NDVI between these layers (2015 and 2020).
Name the created layer as “2015-2020”, and save it to the “MODIS” folder.

You will get a new layer, displayed in shades of grey. Visualize it in color. Select the following in
the settings panel:
Render type: Singleband pseudocolor;
Interpretation: Linear (for a continuous color scale);
Color ramp: Spectral;
Classes: 9;
Mode: Quantile.
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You will get a map where the values close to “0” indicate negligible (if any) changes in the NDVI, the
values close to “+2” (appear bluish) stand for the territories with higher NDVI values on 01.06.2015,
compared to 01.06.2020, and the values close to “–2” (appear reddish), on the contrary, indicate the
territories with higher NDVI values in 2020 compared to 2015.

116

Check yourself
Why do you think the NDVI values in 2015 and 2020
differ?
How has the vegetation rate changed in the Sea of Azov?
Think about the potential causes of such changes
Additional Task
Create a map of the Normalized Difference Vegetation Index as of June 1 of the current year and
compare it with that as of June 1, 2015.
Scan the QR-code below to watch the video tutorial on the performance of this Task.

5.2. Assessing Vineyards in Crimea Using Sentinel-2 Data
Case
There are 250 hectares of vineyards belonging to the Alma Valley production farm located near
the settlements of Vilino and Pishchane.1 All vineyards are equipped with a drip irrigation system.
According to the Alma Valley website, the first seedlings of European varieties were planted in the
Alma River valley in 2008. The company's winery began operating in 2013, and the commercial sale
of wines started in the summer of 2015. In 2017, the company announced the purchase of 1,000
hectares in Sevastopol and the construction of a new production complex there,2 as business at Alma
Valley was successful. In 2020, water scarcity lead to reduced yields, and threatened the planting of
new vineyards on the Peninsula. How do Alma Valley vineyards appear on the satellite images taken
in 2017 and 2020?
Task
Compare the Alma Valley’s vineyards on the Crimean Peninsula in August 2017 and 2020 according to the NDVI index using Sentinel-2 satellite images.
Task performance algorithm:
1. Download satellite images dated August 24, 2020, and August 25, 2017, from EO Browser.
2. Create a Normalized Difference Vegetation Index (NDVI) layer for the specified dates.
3. Visualize the difference between NDVI values as of these dates in the Alma Valley’s vineyards.

___________________________________________________
1
2

URL: http://alma-valley.ru/
URL: https://www.forbes.ru/biznes/372873-novyy-hozyain-massandry-chto-zhdet-legendarnyy-brend-posle-privatizacii
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Instructions for self-guided work:
1. Open EO Browser at https://apps.sentinel-hub.com/eo-browser.
2. Log in to your account.
3. In the search bar, enter “Kacha, Sevastopol City”, and click on the first highlighted line to zoom
to the area of interest.

Using the navigation buttons, zoom to the southwestern part of the Crimean Peninsula. The places where the vineyards grow are located close to Kacha urban-type settlement.

4. In the Discover tab, select:
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•

Data source – Sentinel-2;

•

enable Advanced search and select L2A (atmospherically corrected);

•

Time range – 01.08.2020 – 31.08.2020;

•

Max. cloud coverage – 60%.

5. Select the image taken on August 24, 2020, from the list of search results.

6. Zoom to the vineyards of Alma Valley company, which are located closest to the barns where
the grapes are stored (landmark: vineyards between the settlements of Vilino, Kocherhino, and
Vidradne).
Important! When downloading, the part of the image you see on your screen will be saved.
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Additional task
Find this area in Google Earth: the image
resolution will allow you to see the Scythian
burial mound of the 2nd century BC near the
company's winery.

7. Download the Sentinel bands required for the NDVI display: NIR = B8; Red = B4.
Using the Download image tool
, download the required image bands. In the download settings panel, select:
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•

Analytical tab;

•

Image format – TIFF (32-bit float);

•

Image resolution – HIGH;

•

Coordinate system – WGS 84 (EPSG 4326);

•

Layers – B08 and B04.

Once you have selected the required parameters, click Download. The downloaded zip file containing satellite images will look like
.
Create a “Sentinel” folder for saving unzipped satellite imagery.
8. To open B08 and B04 bands in QGIS:
•

click

•

press Ctrl+L to open the Data Source Manager dialog box. Under Raster, specify the path to
the images in the “Sentinel” folder → Add;

•

as a result, appropriate spectral bands will be loaded to your project;

•

rename the bands, leaving only the band names, “B08” and “B04” (right-click on the layer
name in the Layers → Rename layer).

(Start → Programs → QGIS 3.16 → QGIS 3.16 with GRASS);

9. To create the NDVI layer:
•

use the Toolbox item from the menu of the Processing tab;

•

in the Processing Toolbox dialog, go to SAGA → Image analysis → Vegetation Index (Slope
Based). Specify the following: Near Infrared Reflectance – B8; Red Reflectance – B4;

•

in the Normalized Difference Vegetation Index field, specify the path, Save file to, for saving
the generated layer entitled “NDVI_2020” (“Sentinel” folder, which we have created) → Run;
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Important! All the layers that we create must be named using Latin characters; otherwise, the
result may be incorrectly processed by the program.

•

the “NDVI_20” layer that you have created will display in the Layers tab in shades of grey.

Important! If the Vegetation Index (Slope Based) module works incorrectly or shows an error
(due to the old version of the program), you can use the Raster calculator to determine the NDVI as in
the previous task.
10. Display the created layer in green gradations:
NDVI layer → Properties → Symbology
In the settings panel, select:
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•

Render type – Singleband presudocolor;

•

Interpretation – Linear (for a continuous color scale);

•

Color ramp – Greens;

•

Classes – 10;

•

Mode – Equal interval.

11. As a result, you will get the NDVI map of the Alma Valley vineyard fields as of August 24, 2020.

12. Using the same algorithm, calculate the vegetation index for the vineyard in 2017 (name the
layer as “NDVI_2017”) in QGIS:
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•

download appropriate bands (to display the NDVI index) of the satellite image dated August
25, 2017, from EO Browser;

•

create a layer “NDVI_2017” in QGIS.

13. Visually compare two NDVI layers: as of 2020 and 2017.
Check yourself
Why do you think the NDVI index in the
fields of Alma Valley company has changed?
14. Compare two NDVI layers (2020 and 2017) using the Raster Calculator tool:
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•

open Raster calculator tool from the menu bar under Raster tab;

•

assign “Compare” name to the file and specify the path for saving the resulting layer to the
“Sentinel” folder;

•

in the expression field, specify that the NDVI value of 2020 should be subtracted from that of
2017;

•

the resulting layer (representing the difference of the value for the selected two years) will
display in the Layers tab;

•

change the display from grey to color. Adjust the “compare” layer to see the area of the vineyards: Properties → Symbology.

In the settings panel, select:
•

Render type – Singleband pseudocolor;

•

Interpretation – Linear (for a continuous color scale);

•

Color ramp – Spectral;

•

Classes – 5;

•

Mode – Quantile.
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Thus, we have determined the difference between NDVI_20 and NDVI_17 layers. The areas where
the vegetation index was lower in 2020 than in 2017 appear red on the resulting map, and blue are
areas where the vegetation index was higher in 2020 compared to 2017).
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Therefore, there are different trends in the NDVI changes in the same field of Alma Valley company equipped with drip irrigation system observed over three years.
Check yourself
Hypothesize about possible causes of the decrease in the NDVI values in the northern part of
the field and the increase in the NDVI values in
the southern part of the field that occurred over
three years (hint: look for the answer in Google
Earth, namely – in the historical images of this
area).
Scan the QR-code below to watch the video tutorial on the performance of this Task.
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6. Water Indices to Identify Water Dynamics and
Wetlands
6.1. Investigating Changes in the Hydrological Regime of
Bondarivske Swamp
Case
The Polissia region is substantially dehydrated, primarily due to the past land reclamation (largescale drainage of swamps), and current massive deforestation. In the spring of 2020, large fires occurred. The Polissia swamps are an extremely important source of water for Ukrainian rivers. Due to
the destruction of swamps, our rivers are drying up and the climate is changing. For the first time in
120 years, Ukraine finds itself in a situation where most rivers have low water levels. This is caused by
the abnormal autumn and winter temperatures in 2019-2020.1
Task
Investigate changes in the hydrological regime of Bondarivske Swamp in the springs of 2018 and
2020.
Task performance algorithm:
1. Download satellite images as of April 8, 2018, and April 5, 2020, from Google Drive or EO
Browser.
2. Create a merged false-color satellite image as of these dates.
3. Calculate the MNDWI water index for both Sentinel-2 images.
4. Visualize the difference in soil moisture distribution histograms of in Bondarivske Swamp as of
these dates.
5. Select the MNDWI threshold values and create a map of the wetland area for two years.
Instructions for self-guided work:
1. Download the Sentinel-2a satellite images taken on April 8, 2018, and April 5, 2020, of Bondarivske Swamp area (near Otrokhy Village, Kozeletskyi District, Chernihiv Oblast) from: https://
drive.google.com/drive/folders/1NfwGVGXwfyGtMMLJmMVTslaeytx_RURh?fbclid=IwAR1omaWbqTc1TSRg-jIkP6cAmXRNRM22C1-ng-9fwu0Md3nXIvAAcr6btus.
2. Unzip the downloaded archive. Satellite image bands can be found in the internal archive files,
in the GRANULE and IMG_DATA folders.
3. Open QGIS Desktop 3.10.4 and create a new project.
4. First, merge the bands for Sentinel-2a image taken on April 8, 2018. To merge black-and-white
bands of the satellite image into one color image, click on Raster in the top menu, expand the Miscellaneous tab → Merge.

___________________________________________________
1
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URL: https://greenpost.press/news/osushennya-bolit-nam-shhe-dobryache-gyknetsya-ekspert-i2447

A Merge dialog box will pop up, in which you need to specify the bands you want to combine in
the Input Layers field. To do this, click on the icon
next to the Input Layers field and pick Add
files from the Multiple selection dialog, find the folder where the image bands are saved and select
the desired bands.
5. Create a merged false-color satellite image using B12, B8, B4 bands (this combination will help
you to roughly determine the content of water in plants and soil, since it is reflected in the SWIR
wavelength). You can select three bands at once by holding down the “Shift” or “Ctrl” key on the
keyboard. Then you need to click Open, and the selected images will be downloaded to the Multiple
selection window. It is important to select bands in the following sequence: R (B12 – SWIR), G (B8 –
NIR), and B (B4 – red). Therefore, you need to drag the bands in a way so as to display them in the
following sequence, B12, B8, B4, and click Ok.

As a result, the selected bands (i.e. three bands) will be displayed under Input layers in the Merge
dialog. Tick the box next to Place each input file into a separate band, click on the icon
next to
the Merged field, select Save to file, find the path to the folder, name the file, and click Run.
Important! It is better to use Latin characters to name the files. Cyrillic is not always correctly
processed by programs.
You will get a merged satellite image as of April 8, 2018. To perform a comparative analysis, however, it is necessary to develop an appropriate algorithm for the zipped images as of the two dates
that you have previously downloaded. Therefore, repeat all the above steps for the next satellite image
taken on April 5, 2020.
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If you did everything correctly, a large image will be displayed on the screen showing the Kyiv
Cistern on the left and the Desna River in the center. Bondarivske Swamp is located between them
(the top of the Cistern and the Desna River). With this combination of bands, the bodies of water
appear blue, the forest is green, open ground (fields, felling sites, and meadows) appears light brown
and pink.
Check yourself
Take a closer look at the Desna floodplain in front of Bondarivske Swamp, as
well as upstream and downstream in 2020.
Why do you think it contains some dark
areas? Specify the potential causes.

Take a closer look at the upper eastern part of the 2018 image and specify
what types of land are affected by the water-abundant spring period. Do you think
the effects of these water flows on natural
and agricultural landscapes are the same?

Zoom to Bondarivske Swamp and visually compare its appearance in two satellite images taken
in 2018 and 2020.
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Visually comparing these two images, you can conclude that the swamp humidity levels in these
years differ significantly.
6. Calculation of the MNDWI water index for two Sentinel-2 images.
Modified Normalized Difference Water Index (MNDWI) is a standardized differentiated moisture index used for monitoring droughts and enhancement of open water features.
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The water index formula:
MNDWI = (Green-SWIR)/(Green + SWIR)
where: Green – the green band of the range; SWIR – the medium infrared band.
For Sentinel-2, the MNDWI formula will look like this: (B3-B11)/(B3 + B11).
First, add bands 3 and 11 from the 2018 image to your project. You can do this quickly by simply
dragging them from the Explorer window to the corresponding QGIS Layers window.

Next, we will use the raster calculator. For this, open the Raster tab → Raster Calculator.

In the corresponding field of the Raster Calculator window, enter the formula (Green-SWIR)/
(Green + SWIR), where Green and SWIR are the bands you have selected from the menu at the top
of the raster calculator dialog.
We can simply enter now the MNDWI formula in the Raster Calculator, substituting the values
of the bands:
(Band3-Band11)/(Band3+Band11)
First, select the appropriate bands from the Raster Bands menu at the top of the window in the
Raster Calculator dialog, and use the appropriate Operators to select the -, +, / symbols. To add layers to the expression box, double-click the desired layer with your left mouse button.
Important! Do not enter the band names from the keyboard because the formula will not run.
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Note that the Ok button at the bottom of the calculator will not be active until you enter a name
and specify a location of the Output layer. Select the desired folder by clicking , and write the
name of the source layer, for example: “MNDWI_08_04_2018.tif ”", where the numerical symbols
indicate the date of the image.
Important! If a file for some reason is not saved, check the paths and file names for Cyrillic
characters and spaces – you should avoid using them.

Repeat now all the above steps for the 2020 image to calculate the water index for 2020. As a result
of calculation with the raster calculator, you should get two water indices of Bondarivske Swamp area
as of April 8, 2018, and April 5, 2020, which will automatically open in your project as black-andwhite raster layers with values ranging from 1 to -1.
Next, you need to immediately clip the resulting index images along the map window to avoid
processing by the program any extra areas of the image and building a stretched histogram. To do
this, place Bondarivske Swamp in the center of your screen, and right-click on the water index in the
project, and select the following from the context menu: Export → Save As.
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In the Save Raster Layer as dialog, click on the icon
next to File Name, and specify the path to
the folder where the image will be stored, as well as its name.
In the Extent block below, select Map Canvas Extent and click Ok.

Important! If you have images with a geographical projection in different areas (in our case, the
image as of April 5, 2020, has a projection of WGS 84 zona 35N, and the image dated April 8, 2018 –
WGS 84 zona 36N), the image with the area that differs from that of the project, should be assigned a
similar area when clipping the image on the desktop – otherwise the image will look rotated.
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To check the correctness of index calculation, we can open the Properties tab of the created
MNDWI layer by right-clicking on it and go to the Histogram tab. The tab that opens will initially be
without a histogram. We need to calculate it by clicking the Compute histogram button.

If the pixel value in the calculated histogram is between -1 and 1 (in our case the value for Bondarivske Swamp ranges from -0.64 to 0.61), your calculation is correct. The more wet the area, the
closer value to +1.
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Save the resulting histograms for comparison to your computer by clicking Save plot.

2018

2020

Check yourself
Compare two histograms of soil moisture
distribution and describe the difference between
them.
7. Selecting MNDWI threshold values and creating humidity maps of Bondarivske Swamp.
To create the Swamp moisture color map, you need to perform the following steps.
To access the raster display tools, right-click on the obtained humidity index first for 2018 –
“MNDWI_08_04_2018_clip.tif ” under Layers, and select Properties from the drop-down menu. In
the Layer Properties dialog that appears, go to the Symbology tab and select the Singleband pseudo-
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color display mode that allows you to group pixels into a given number of classes where the threshold
values of each class can be modified. Next, select Interpolation – Discrete, and change Color ramp
to make the index map look the way we need. We suggest that you choose shades from light blue to
blue (Blues).
The table that appears at the bottom of the page has three columns:
Value – the upper limit of the range;
Color – you can manually select the color of the range;
Label (name) – a text field, where you can label digital limits of the range or provide a short text
description.
Using the Classify button, run the classification for the raster layer. You can also change here the
number of Classes (in our case, there are three classes), and the range they cover by selecting the
Value that best reflects the specified classes.
Important! If the character next to Classes cannot be edited, change the Mode from Continuous
to Equal Interval, and specify three classes.

Next, adjust the range for the land and change its color to light green. To change the values of
the first range manually, double-click on the Value field with your left mouse button, and write the
value -0.12; the second range will have the value 0.24. Therefore, you change mostly the upper limit
between the first and second classes, and all other threshold values can be left unchanged. The main
tip: make sure there are three classes: the first is just land, the second is a wet part of the swamp and
the third is open water area.

Now change the color of the land class from blue to green: click on the blue color of the first class,
and a drop-down window, Change Color, will appear, in which you can choose a convenient display
color (in our case, it is green.
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If you analyze in detail the ranges of MNDWI values on the scale, you will see that according to
the classification, the water index of open water areas will be represented by positive numbers, while
all other values indicate drier areas or open surfaces. Using these threshold values, you should get the
moisture content map for 2018 as shown below; however, it may differ visually within the threshold
ranges, depending on the size of the humidity index fragment you have selected when clipping its
part for Bondarivske Swamp.

Satellite image

Moisture content map

Save the settings of the created 2018 moisture content map to be able to use these styles for another case study, namely, for 2020. To do this, click Export color map to file and apply these settings to
the 2020 water index.

For this, go to the Symbology tab in the Layer Properties dialog that appears, and select Load
color map to file.
As a result, you will get two thematic maps, where open water appears dark blue, the wet area is
blue, and the rest of the area is green. The only thing that remains unchanged on both moisture content maps is a small lake near Bondarivske Swamp, enclosed in a red circle.
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Check yourself
Why do you think the moisture level in Ukrainian swamps changes? Why are swamps important
for the ecosystem of our region in general?
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Scan the QR-code below to watch the video tutorial on the performance of this Task.

6.2. Studying the Scale of the Flood on the Dniester River in the
Summer of 2020
According to a leaflet prepared by the Zoї Environmental Network in the framework of the UNECE/OSCE/UNEP climate projects in the Dniester River basin within the International Environment and Security Initiative (ENVSEC) 1, the basic definitions are as follows:
• flood is a phase of the river water regime, which occurs annually in certain climatic conditions
during the same season; it is characterized by high and prolonged rise and fall of water levels in rivers, lakes, reservoirs;
• freshet is a significant increase in the water levels in rivers within the annual cycle, which occurs
irregularly; it takes place during heavy rains or thaws.
Case
The freshet in Western Ukraine in the summer of 2020 was a natural disaster that occurred due to
intense thunderstorms, resulting in a sharp rise in the water level in the Dniester River. The freshet
peak was observed on June 24-25 and exceeded the scale of a similar natural disaster in 2008, which
caused losses amounting to UAH 3-4 billion.1
Task
Create thematic maps of the flooded area during the freshet on the Dniester River in Halytskyi
District of Ivano-Frankivsk Oblast based on the water index according to the Sentinel-2 satellite
image.
Task performance algorithm:
1. Download Sentinel-2 satellite images dated June 25, 2020, and July 2, 2020, from Google Drive
or EO Browser.
2. Create a merged false-color satellite image for these dates.
3. Visually compare the obtained images.
4. Measure the width of the Dniester River during the freshet.
5. Calculate the NDWI water index for both Sentinel-2 images.
6. Choose the NDWI threshold values and create a map of the Dniester River floodplain during
and after the freshet.

___________________________________________________
1
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URL: https://suspilne.media/43479-velika-voda-pricini-ta-naslidki-zatoplen-na-zahidnij-ukraini/

Instructions for self-guided work:
1. Download Sentinel-2 images dated June 25 and July 2, 2020, of the Halytskyi District of Ivano-Frankivsk Oblast from the USGS Earth Explorer website or from: https://drive.google.com/drive/
folders/1dReNsDzfaRTaczAZ8BTM43x8hnlzdsv4?fbclid=IwAR33GWqZD97t-j8hoFYBYOryZSt94myqfO-SJAGUqmowblSlfP6LVWZybgk.
2. Unzip the images. Satellite image bands can be found in the internal zipped files, in the GRANULE and IMG_DATA folders. Launch QGIS and create a new project called “Freshet”.
3. Let's start creating a merged image.
Create merged image via Raster → Miscellaneous → Merge first for one image taken on June 25,
2020, and then for another one taken on July 2, 2020.

Under Merge, open the bands synthesis dialog, and specify the bands you want to merge in the
Input Layers field. For this, click on the icon
next to the Input Layers field, click Add files in the
Multiple selection dialog, find the folder with the saved image bands, and select the desired bands,
namely: 12-8-4. You can select three bands at once by holding down the “Shift” or “Ctrl” key on the
keyboard. It is important to select bands in the following order: R (B12 – SWIR), G (B8 – NIR), and
B (B4 – red). You should drag the bands in a way as to display them in the following sequence: B12,
B8, B4, and click Ok
Important! Pay attention to the sequence of the bands when creating a merged image. If the
bands are displayed in a different order, change their positions using the mouse.

Upon completion of the Merge operation, the synthesized image in the 12-8-4 bands combination
will be added to the project as a new layer called “Sent_20200625_merge”. Not to confuse the names,
we suggest that you immediately give the name of the layer according to the date of an image. Upon
completion of the same operations, add the next image to your project, named “Sent_20200702_
merge”.
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4. Visual comparison of two images using the Swipe tool.
To make it easier to compare two images, use the Swipe tool from the MapSwipe Tool plugin.
For this purpose, select the following from the top menu: Plugins – Manage and Instal Plugins ... –
Not installed tab. In the search bar, start typing the name of the plugin, “MapSwipe Tool” or simply
“MapSwipe”, and it will appear automatically in the list at the bottom of the screen. Select it from the
list by left-clicking, and brief information about the plugin will pop up, which is worth reading. Click
Install Plugin and close the dialog box. Once installed, the plugin will appear in the Installed tab,
and an icon
will be displayed on the toolbar.

To use the Swipe tool, press and hold down the mouse button as you scroll over the image. You
will notice that the mouse cursor changes depending on its position. This allows you to select the
direction in which you want to temporarily swipe the layer. By holding down the mouse button and
moving the cursor over the image, you can close the top layer in the selected direction.
Your Sentinel satellite images that were merged using the Swipe tool should look as in the figure
below; you can visually compare the scale of the flood now.
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5. Measuring the width of the Dniester River during the freshet.
Add an OpenStreetMap (OSM) to your project for your guidance and identification of the extent
of flooding near different settlements. For this purpose, expand XYZ Tiles from the Browser panel
and double-click on the OpenStreetMar layer to open it in the Layers tab and display in the map
window.

With the Measure Line tool, measure the width of overflow. Select the Line measurement type and
a new Measure dialog will open. Hover over the image captured on June 25, 2020, find the appropri-
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ate settlement, and click once on the right bank of the Dniester River, and the second time – on the
left bank. The respective values for the width of river overflow will appear in the Measure window.
You will need these values to complete the Task, i.e. to verify the following statement. For your convenience, use kilometers as units of measurement.

Check yourself
Calculate the Dniester River overflow width near the following settlements:

Width of overflow, km

Petryliv
Dovhe
Yezupil
Dubivtsi
Halych
6. Calculating the NDWI water index for Sentinel-2 images before and after the freshet.
Water index formula: NDWI=(NIR-SWIR)/(NIR+SWIR). For Sentinel-2, the NDWI formula
will be as follows: (B3-B8)/(B3 + B8).
First, add the required bands (3 and 8) to your project using the Add Layer → Add raster Layer ...,
or simply drag them from the Explorer window to your GIS project window.
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Expand the Raster tab → Raster Calculator from the main menu.

In the corresponding field of the Raster Calculator window, enter the formula for calculating the
water index: NDWI = (NIR-SWIR)/(NIR + SWIR), where NIR and SWIR are the bands you select
from the menu at the top of the calculator window. For the Sentinel-2 image, we substitute the bands’
values:
(Band3-Band8)/(Band3+Band8).
For this purpose, select the appropriate bands under Raster Bands in the Raster Calculator dialog box, use appropriate Operators to select characters for the formula: –, +, /. To add layers to the
expression window, double-click the desired layer with your left mouse button.
Important! Do not enter the file names from the keyboard since the formula will not run.
Note that the Ok button at the bottom of the calculator will become active after you specify the
name and location of the Output layer. Select the desired folder by clicking , and write the name
of the source layer, for example: “Sent_20200625_NDWI.tif ”, where the digital characters indicate
the date of the image.
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Important! If the file is not saved for some reason, check the paths and file names for Cyrillic
characters and spaces – you should avoid using them.

As a result of calculation with the raster calculator, you will get two water indices for the Dniester
River area as of June 25 and July 2, 2020, which will automatically open in your project in the form
of black and white raster layers with values ranging from 1 to –1.
5. Selecting NDWI thresholds and creating maps of the Dniester River during the freshet illustrating high water levels.
To create a color map of the Dniester River water level during the freshet, you need to perform a
series of steps using the image captured on June 25, 2020.
To access the raster display setting tools, right-click on the NDWI layer under Layers and select
Properties from the drop-down menu; next, go to the Symbology tab in the Layer Properties dialog
that appears, and select the Singleband pseudocolor display mode. This mode allows you to group
pixels into a given number of classes, and change the thresholds for each class. Next, select Color
Interpolation – Discrete (Discrete scale), and change the Color ramp so that the index map has the
appearance that we need. We suggest that you choose shades of blue. The table that appears on the
page below has three columns:
Value – the upper limit of the range;
Color – you can manually select the color of the range;
Label – a text field, where you can specify the digital limits of the range, or make a short text description.
To select the water index thresholds for only two classes, water, and land, change the Mode from
Continuous to Quantile, and write “2” in the Classes field. As a result, you will get a map where not
only water but also clouds are displayed as one class. This is characteristic for the clouds display;
therefore, to reduce the number of clouds, change the Value settings from – 0.3590418 to – 0.1590418.
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By editing the Value, you can best display the scale of the flood under study. Once we have set the
threshold values, we shall make the land class transparent: right-click on the color designation of the
first class and select Change Opacity, and replace 100% with 0%. While doing this, the OSM base
map should be open in the background.

As a result of all transformations, you will change the appearance of the water index from a blackand-white gradient raster to a raster with two classes: <= -0.1590418 (land), and > -0.1590418 (water).
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Water index before setting the threshold values

Water index upon setting the threshold values

To quickly assign the already selected values (that we have set for the image taken on June 25,
2020), to the next image taken on July 2, 2020, according to the image dated June 25, 2020, select
Style
→ Export color map to file on the bottom left-hand side of the screen from the Layer Properties window under Symbology. For the image captured on July 2, 2020, click Style → Load color
map to file
and select a style file that was previously downloaded to your computer. In this case,
we have used the same style template for two raster layers to make it easier to compare them. As a
result of all transformations, we have obtained thematic raster layers that can be further converted
into vector layers, and based on which, the area of flood in the reservoir can be calculated.
You can compare the results by superimposing them on the OSM map or overlapping two water
index images.

June 25, 2020

July 2, 2020

To make the water appear differently on the map in different months, change its color to blue
in the image taken in June: go to the Layer Properties window and select Change Color under
Symbology.
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Check yourself
What do you think are the main causes of abnormal heavy
rainfalls? And why do the Carpathians and Zakarpattia suffer
from floods most often?
Scan the QR-code below to watch the video tutorial on the performance of this Task.
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7. Applications of Radar Imagery
7.1. Detecting Ships Operating in the Area of Tokyo Bay
The term “quarantine” derives from the Italian “quaranta giorni”, meaning 40 days – the length
of time ships from infected ports had to sit at anchor in Venice during the 14th-century bubonic
plague epidemic. This system, which was used by Italian cities, was later adopted by other European
countries.1
Case
Cruise ships carrying a large number of people often become the settings for outbreaks of infectious diseases because of the crowded semi-enclosed environments and limited medical resources.
Outbreaks of COVID-19 on cruise ships pose a risk for a rapid spread of disease beyond the voyage.
The Diamond Princess was the first cruise ship to experience a major COVID-19 outbreak on
board. In early February 2020, an elderly passenger who disembarked in Hong Kong was tested positive for the coronavirus. The liner was then quarantined off the coast of Yokohama (Japan). From
February 4, 2020, for approximately a month, people remained on board, some confined to their
cabins, often without windows. The infection spread four times faster on the cruise ship than in Wuhan (the city where the first COVID-19 outbreak was recorded). A major outbreak aboard the ocean
liner eventually led to nearly 700 infections and 14 deaths from coronavirus. In February 2020, the
Diamond Princess had the second-highest COVID-19 infection rate in the world.2
Task
Identify Singapore in the radar (Sentinel-1) and multispectral (Sentinel-2) images taken on January 31, 2020. Using EO Browser scripts, experiment with the radar image of Yokohama Port taken on
February 4, 2020 (a time when Diamond Princess cruise ship was under quarantine), download the
processed image and animation, create a map layout in QGIS.
Task performance algorithm:
1. Run scripts in EO Browser.
2. Download data from EO Browser (image and animation).
3. Open the image and vector layer in QGIS.
4. Download the image from Bing.
5. Create a map layout.
Instructions for self-guided work
In this Task, we will use radar imagery acquired by the Sentinel-1 satellite. The Sentinel-1 mission
is a constellation of two satellites that monitor Earth day and night and deliver radar data.
Unlike multispectral images, radar images do not show a clear picture due to the presence of granular noise – flashes, vortices, speckles, and waves. To generate a clearer image and reduce granular
interference, it is necessary to stitch together and filter several images. The SNAP software (http://
step.esa.int/main/download/snap-download/) has been specifically developed for Sentinel-1 images’
preprocessing and offers a series of toolboxes for the performance of the above-mentioned operations. However, to make our work with radar data easier, we will use EO Browser for downloading
Sentinel-1 images that have already undergone script processing.
___________________________________________________

URL: https://time.com/5799525/coronavirus-covid19-quarantine-ships-history/
URL: www.theguardian.com/world/live/2020/feb/20/coronavirus-live-updates-diamond-princess-cruise-ship-japan- deathslatest-news-china-infections
1
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Imaging radars, although complex systems, have some advantages, namely:
•

can operate under any weather conditions;

•

independent of sunlight as they have their own source of energy;

•

sensitive to water, biomass, ice, and surface roughness;

•

can measure distances accurately;

•

sensitive to anthropogenic (man-made) features.

1. We will start our work in EO Browser: go to EO Browser’s website, enter your login and password.
Using the search bar, identify the location of Singapore, one of the largest port cities in the world,
on the map.
First, let’s compare Sentinel-2 multispectral data and Sentinel-1 radar data. In the Search tab.
•

select Data sources: Sentinel-1;

•

turn Advanced search on. Leave unchanged all default settings (don’t uncheck the boxes):
Data location, Acquisition mode, Polarization, Orbit direction;

•

set the Time range: 2020-01-30 – 2020-02-01;

•

click the Search button.

In the list of search results, select the Sentinel-1 image taken on January 31, 2020, and click Visualize. The Sentinel-1 image will be automatically displayed as a SAR urban product. Leave it unchanged and click the Add to compare button – the image will be added to the Compare tab.
Return to the Search tab and select the next data source – Sentinel-2. Toggle the Advanced search
on and tick the L2A (atmospherically corrected) box. Set the Time range: 2020-01-30 ‒ 2020-02-01.
Click the Search button.
Download the Sentinel-2 image taken on January 31, 2020, click Visualize, and add this image to
the list for comparison by clicking the icon.
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Switch to the Compare tab and compare the Sentinel-1 and Sentinel-2 images taken on the same
date (January 31, 2020) by dragging the slider next to the top image.

Sentinel-2 True color

Sentinel-1 SAR-urban

View of Singapore as of January 31, 2020 (Sentinel-2 and Sentinel-1 images)
Check yourself
What is the most obvious difference between
Sentinel-2 and Sentinel-1 images? Why do you
think the images differ?
What coastal area of Singapore has the largest
number of ships?
2. EO Browser makes your work with radar data much easier due to the availability of numerous
custom scripts. After all, good visualization can help you focus on specific aspects, and create images
that are more understandable to people who do not work with satellite imagery. Therefore, the next
step will be to experiment with scripts and download images of Yokohama port, where the Diamond
Princess ocean liner was kept under quarantine for more than a month.
Using the search bar, identify Yokohama Port (Japan) in the map:
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•

set Data sources: Sentinel-1;

•

turn Advanced search on and leave all default settings unchanged: Data location, Acquisition
mode, Polarization, Orbit direction;

•

set Time range: 2020-02-20 ‒ 2020-03-01;

•

click the Search button.

In the search results window, select the Sentinel-1 image taken on February 27, 2020 (Sentinel-1
AWS-IW-VVVH, 2020-02-27, 20:43:21 UTC), and click Visualize. The Sentinel-1 image will automatically be displayed as the SAR urban product. SAR urban combination is well suited for detecting
urban areas and individual buildings and making mountain terrain more distinctive. It uses VH and
VV polarization to highlight different buildings. You’ve probably noticed already the ships, which
can be distinguished with this combination (dots, dashes, and crosses in a black background) in the
image of the bay.

In fact, SAR urban is not well suited for our purpose because we have to investigate water surfaces.
Let’s try out other scripts for visualization.
Important! Please note that a color radar image is the product of post-processing; initial data is
black-and-white and contains two polarizations – VV and VH, which need to be further processed and
calibrated. EO Browser simplifies this procedure and allows us to use already processed data (try out different polarization options from the left-hand sidebar in EO Browser).
3. Let’s proceed to visualization options using scripts. Select Custom from the left-hand sidebar:
you can create your own band combination under Composite by dragging the bands onto R, G, B
fields. As you change the band composite, the image in EO Browser window will change accordingly.

153

However, of our interest is the Custom script tab. Switch to this tab, and a script window with the
code description of the image scene will appear on your screen. This does not mean, however, that we
will learn a programming language now and write our own script – we will use the scripts from a repository of Sentinel-1 custom scripts available at: https://sentinel-hub.github.io/custom-scripts/#sentinel-1 (select Sentinel-1 section).
Go to the page using the above-mentioned link and you will notice that all scripts for Sentinel-1
are grouped into several categories. Select SAR false color visualization 2 under Other available
scripts. The page provides brief information about the script and indicates its author; you can also
view the examples of radar images produced with this script. Click the Show script button and copy
the whole text that appears in a black background.

The interface of a web platform that provides a collection of custom scripts for EO Browser
(source: https://sentinel-hub.github.io/custom-scripts/#sentinel-1)
Return to EO Browser, replace the existing script with the one you just copied, and click Refresh.
The resulting image will be displayed in blue and yellow shades (blue for water, yellow for land). If
you zoom to Yokohama port, you can see yellow spots and dots on the water surface – these are the
ships. On February 27, 2020 (the date of the image), the Diamond Princess liner was anchored at the
port, and you can see it in the image.
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4. Save this image using the
Download image image tool. The part of the image you see on the
screen will be saved during downloading. To do this, open the Analytical tab in the image download
dialog, and perform the following settings:
Show logo ‒ turn this function off;
Image format ‒ TIFF;
Image resolution ‒ High;
Coordinate system ‒ WGS 84;
Layers ‒ Custom.
Click the Download button and specify the path to save the archive to your computer.
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5. You can also save a short video demonstrating the movement of ships from early January
through the end of May 2020. First, select the visualization mode from the list in the Visualize tab or
from the collection of scripts. In our example, we have used SAR urban. To save the animation, first,
click the
icon on the right-hand sidebar, zoom to the map to display the ships present in the bay,
click the selected area of your screen (navigate by the video playback arrow) – a new dialog box will
appear where you can select images. Set the time range, for example from early January 2020, to the
end of May 2020, and image frequency – 1 image per day, and click Search. In the list of downloaded
images below, uncheck the incomplete images or the ones you don’t like. Check the boxes next to the
images you want to see in your animation. By clicking the video play button located on the bottom
panel under the animation, you can play the video. You can also change the playback speed. If you
are satisfied with everything, click the Download button.

With this animation, you can see the movement of ships during the selected period. You can also
add any images from the Pins library to the animation. The advantage of this type of animation is that
you can use the images from different libraries, and add already processed images, terrain models,
etc. Moreover, this animation may be used to demonstrate the outputs of your images’ processing:
view the images before and after processing, with/without application of scripts, and many more.
Unfortunately, such animation cannot be added to a static map layout, which creation is discussed
below. However, you can add it to your presentations and use as illustration of your research results.
6. We will proceed with our work in QGIS. Download the image that was saved with EO Browser
to your project. You can open the image simply by dragging it to the map view window, or using the
tools from the main menu: Layer – Add Layer – Add Raster Layer. Click the three dots button next
to Raster dataset(s), specify the path to the file you have previously downloaded, and click the Add
button.
Export an image displaying all the ports where the Diamond Princess liner moored to your project. Select Add Layer – Add Vector Layer from the Layer menu. Click the three dots button next to
Vector Dataset(s), specify the path to the file (first, download it from https://drive.google.com/drive/
folders/17oU03XEHk7a-Jo362AwIlpT503hWs5Kk), and click the Add button.
Adjust the points display and label them. To access the shapefile settings tools, right-click on the
vector layer, select Properties from the drop-down list, and switch to the Symbology tab in the Layer
Properties dialog box that appears.
In the Favorites module at the bottom of your screen, you can choose the symbol for a shapefile
features display. Color and size settings can be made in the module located above the Favorites.
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To add labels, go to the Labels tab and switch to Single labels in the drop-down menu. Select the
value for the labels from the Value list (in our case it is Data), and click the OK button. In this window, you can also customize the labels display by adding a shadow, highlighting, changing the size,
and many more.

7. Add a layer with contemporary high-resolution satellite imagery to your map document. In
the Browser panel, expand XYZ Tiles top-level node, select Bing Image (we have already added this
layer to the map in one of our previous tasks, Changes in the Upper Boundary of the Maramureș Forest
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Massif), and double-click it with the right mouse button to add to your project. You can add any layer
as a common basemap, e.g. OpenStreetMap.

8. It is often necessary to create a map that can be printed or exported to a document. QGIS has a
powerful tool called Print Layout that allows you to take your GIS layers and package them to create
maps. We will create a layout with standard map elements like the map inset, north arrow, scale bar,
and labels.
To switch to the map composition and layout display mode, open the Project menu and select
New Print Layout. Enter a unique print layout title in the Create print layout Title dialog, or leave
the field empty and click the OK button.

In the print layout window, click the Add Item button and select Add Map from the list. You will
see that your mouse cursor has changed. Using the mouse cursor, draw a rectangle on the blank sheet
page where you want to insert the map. You will see on your screen the same map as in the main
QGIS canvas.
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Using the Add Item menu, add a north arrow (select Add North Arrow), a scale bar (select Add
Scalebar), and Add Picture to the map.
The list of elements that can be added to the layout page includes the following:
•

Legend item allows you to adjust the appearance of symbols and their properties. When this
item is activated, a corresponding dialog box shows up, in which you can specify the thematic
layers to be displayed in the legend items, and set text parameters for the Legend;

•

North Arrow ... is a tool for adding this item and adjusting its properties;

•

Scale Bar ... allows you to add this item based on parameters selected from the Scale Bar Selector dialog box for the desired map frame;

•

Picture item allows you to add raster and vector images to the map layout. For example, let’s
add a picture of a ship. First, search for the picture in Google and save the result. Specify the
path to the picture file in the Image source dialog.

Now, let’s add a map name: using the Add Label from the Main Properties window, enter Diamond Princess Cruise Ship Route during COVID-19 Outbreak. Adjust the font size and type in the
Appearance tab.
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Add a Sentinel-1 radar image taken on February 27, 2020. To do this, return to QGIS and zoom
closer to the image: right-click on the layer and Zoom to Layer. Go back to the layout, add a new map
using Add Map, and add a label and a scale bar to your map. To display exactly the same image as you
have in your map view window, select the map and check the Frame box.

You can also add a short description to the map under Add Label.
After all the elements have been added to the map, save the layout as an Image or PDF file using
the appropriate commands from the Project menu.
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An example of a finished map layout is shown below.

9. On the https://www.vesselfinder.com website, you can track the movements of the world’s ships
sailing the ocean. For example, a suspicious vessel that is involved in illegal fishing or smuggling operations. However, it is not possible with a free version of this service to save and export the track of
a ship; the free version allows you to see real-time positions of vessels and their recent port calls only.
Go to https://www.vesselfinder.com, and enter Diamond Princess cruise ship name in the search
bar. Select this ship from the list by clicking on its name, and a new page with ship details will open.
Here you can read more information about the vessel, see its photos, and many more. Most of the
data about the ship are presented in the Position & Voyage Data section: vessel type, course and
speed, coordinates, and the timestamp of the received data.
Important! Some vessels may have identical names. The Diamond Princess is a passenger cruise
ship, so take this into account when searching to select the right ship from the list.
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By clicking the Track on Map button below the ship photo, or the map image under Map Position
& Weather, you can switch to the map displaying the current position of the liner (the cruise ship will
appear bright green in the map and thus may be distinguished from other vessels). Zoom to the map
to see the port name and ship location, and take a screenshot using the Print Screen key. Crop the
screenshot so that it captures the map as shown in the image below. Save a map of the vessel’s location
as of the date of this task. The image can also be added to your map layout.
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Check yourself
Specify the country off which coast the Diamond Princess cruise ship was sailing as of the day
of this task?
Specify the most recent calling port of the Diamond Princess.
Scan the QR-code below to watch a video tutorial on the performance of this Task.
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7.2. Detecting Oil Pollution in the Mediterranean Sea
In March 2021, the world celebrated its fifty-first Earth Day. This tradition began with a large-scale
demonstration in New York in 1970. A year before, the largest oil spill in the US history occurred off
the coast of Santa Barbara (California). The public response to this disaster has become a powerful
stimulus for the development of the environmental movement.
The biggest losses of oil occur during its transportation from production sites. Accidents involving
oil tankers, drilling rigs, or subsea pipelines account for only 25% of all oil spills at sea, while 75%
result from routine transportation operations.1 During accidents, however, with up to 40-50 thousand
tons of oil released, the affected area may reach about 100 km.2 Major sites of oceanic oil spills are
located on the routes of tankers between the Middle East and Europe, America, and Japan. Significant
marine oil pollution is also observed in the Mediterranean Sea, Caribbean Sea, South China Sea, and
the Sea of Japan.3
According to the US Environmental Protection Agency, only 10 minutes after one ton of oil enters
the water, a 10 mm thick slick forms on its surface. Over time, the slick gets thinner (less than 1
mm) as oil continues to spread, covering an area up to 12 sq. km. In the absence of wind, waves, and
currents, 1 m3 of crude oil disperses over a radius of 50 meters in an hour and a half. Further changes
take place under the combined impact of weather, wind, and waves. Elimination of such pollution
can take several months or even years.
The oil film changes the composition of the spectrum and the intensity of light penetration into
the water. Light transmission through thin films of crude oil ranges from 10 – 11% (280 nm) to 60 –
70% (400 nm). A 30-40 nm thick film completely absorbs infrared radiation.4
Case
On October 7, 2018, two merchant ships collided in the Mediterranean Sea. According to reports,
a Tunisian cargo ship crashed into the hull of a Cypriot container ship north of the French island of
Corsica. There were no victims but the collision caused a fuel spill.
The incident resulted from a series of human errors: the captain of a Tunisian vessel talked on the
phone and ignored the radar. In addition, the Cypriot ship was anchored in the “inappropriate” area.
Damage to the vessels was estimated at 13.5 million euros, plus cleanup costs estimated at 10 million
euros.5
To watch the video of the collision provided by the Vesseltracker, go to: www.youtube.com/
watch?v=AgXqpUCXwhU.
Task
Using the radar images, locate the fuel slick, measure its length and calculate the area covered by
it. Analyze how pollution has spread in the sea.

___________________________________________________

Ferraro G., Tarchi D., Fortunu Jo., Sieber A. (2004) JRC 172 Experience in the Field of Satellite Monitoring of Accidental
and Deliberate Marine Oil Pollution. Joint Research Centre, Via E. Fermi, 1, I-21020 ISPRA (VA) Italy. URL: http://serac.
jrc.it/midiv/ pdf/eurisy.pdf
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Кучма Т. Л. Картографування нафтових розливів у Чорному та Азовському морях за даними дистанційного
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Task performance algorithm:
1. Download required data to your project using EO Browser.
2. Display images in QGIS.
3. Measure the length of the slick as of October 8, October 9, and October 14.
4. Digitize the area of spilled fuel on different dates.
5. Animate digitized data using the TimeManager plugin.
Instructions for self-guided work
1. Go to EO Browser website, enter your login and password.
Using the search bar, find the island of Corsica in the Mediterranean Sea on the map.
In the Search tab:
•

select Data sources – Sentinel-1;

•

select Time range: 01-10-2018‒13-10-2018;

•

Click Search.

Pick the image taken on 08.10.2018.

2. Satellite radar images are well suited for monitoring oil spills spread because the presence of
oil on the water surface weakens the movement of waves. Radar mostly measures the texture of the
surface; oil slicks are clearly visible – they appear black in a gray background. For example, the Figure
below shows one of the largest oil spills in the Gulf of Mexico, which occurred in 2010.
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Oil slick in the Gulf of Mexico
(NASA, International Space Station, April 5, 2010)
The Mississippi Delta and the waters off the Louisiana coast appear dark in the lighter area. This
phenomenon is caused by sunlight, which is reflected from the water surface.1
However, with the SAR-urban combination (the first to open automatically in EO Browser), you
won’t see any oil slicks.
Check yourself
Why is oil pollution not visible with the SARurban combination?

___________________________________________________
1
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URL: https://www.flickr.com/photos/nasamarshall/4583800305/in/photostream/

Use the Water surface roughness visualization script (marine and other water bodies algorithms)
to see the fuel slick north of the island of Corsica. For this, go to https://custom-scripts.sentinel-hub.
com/ and select the desired script from the Sentinel-1 collection.

Interface of custom scripts of repository for EO Browser
(source: https://custom-scripts.sentinel-hub.com/)
The selected script visualizes the surface roughness based on the Sentinel-1 data and is used to
monitor the water surface (ships, oil pollution, sea currents, etc.).
Go to the script tab, click the Show button and copy the text that appears in a black background.

Water surface roughness visualization script download interface
(source: https://custom-scripts.sentinel-hub.com/)
Script text:
var val = Math.log(0.05/(0.018+VV*1.5));
return [val];
Return to EO Browser, scroll down the automatic visualizations in the left sidebar, switch to the
Custom tab, select Custom script box, and paste the copied text in the box. Click Refresh.
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The image visualization will change completely, and it will be possible to see the slick caused by
the released fuel and localize the vessels (appear as black crosses at sea).
Check yourself
Select the previous date from the calendar, and
assess the fuel slick on the first day of the collision.
What factors impact the direction and area of pollution spread in the sea?
3. Download images captured on October 8, 9, and 14, 2018. Zoom to the slick on the image taken
on October 8 and click
at the right sidebar. In the window that opens, select the Analytical tab
and specify:
•

Image format – TIFF;

•

Image resolution – High;

•

Coordinate system – Popular Web Mercator;

•

Layers – Custom.

Click Download and specify the path to save the archive to your computer.
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You may see a message appearing during downloading; it will not affect the download, so don't
worry.

Change the date in the calendar and repeat the download procedure for the images taken on October 9 and 14.
4. Open QGIS and download the images we have earlier saved with EO Browser to your project.
To open these images, simply drag them into the program window, or use the main menu: Layer –
Add layer – Add raster layer. In the Raster dataset(s) field, click the three dots icon, specify the
location of the file you have previously downloaded, and click Add.
Also, add an OpenStreetMap to your project (from the XY Tiles menu in the Browser panel) to
make sure the images are displayed in the correct location.

5. Zoom to the localized slick and using the Ruler tool, measure the length of the oil slick (kilometers) as of October 8, 9, and 14.
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Check yourself
Length of the fuel slick
On October 8
On October 9
On October 14
Digitize the slick as of different dates. Create a new polygonal vector layer. On the toolbar, select
New shapefile layer . In the window that opens, click the tool
next to the File name field to find
the desired folder for saving a new vector layer. Enter its name, e.g. “oil_area”, and click Save.
In the Geometry type box, select Polygon from the drop-down list. In the map projection box,
select WGS 84 / Pseudo-Mercator. Add “Date” by selecting the appropriate type from the list in the
Type field. Click Ok and a new vector layer will open in your project.

Activate vector layer editing mode: left-click the layer in the list, and click on the Toggle Editing
tool . Upon enabling the editing mode, some tools appear with colored icons, i.e. became active.
Select the Add Polygon Feature digitization tool and start delineating the oil spill area boundaries
from the first image taken on October 8, 2018. The entire boundary can be vectorized with a single
polygon. To complete the digitization, right-click, and fill in the Attribute Table; be sure to specify the
date of the image from which you digitize the pollution (you can quickly retrieve from the file name).
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As the pollution areas on different days overlap, we suggest that you change the polygon transparency. To make the digitization of polluted areas as of October 9 and 14 more convenient, complete
the editing and save all changes.

7. As a result, you should get several polygons representing oil slicks as of different dates. We
suggest that you paint them in different colors. To do this, right-click the Properties layer, and select
Categorized (from the first line) and “Date” (second line). Click the Classify and Ok buttons.

8. Calculate the area of digitized polygons. First, right-click on the layer, select Open Attribute
Table, and pick Open field calculator from the toolbar. In the new window, check Create a new field
– “Area” - Decimal number (real) – leave one decimal place – Geometry – $area – Ok.
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Important! Pay attention to the numbers you get when calculating the Output preview. If the
numbers are too large, then the unit of measurement in QGIS will be “square meters”. To change the
units of measurement, go to Project – Properties – Units for area measurement, select “Square kilometers” and calculate the area again.

9. Label the area: right-click on the layer – Properties – Labels – Single labels – Area –
, and
2
add || “km ” to the name of the line from which we take the name for the label, and click Ok.
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10. Download a new TimeManager plugin via Plugins – Manage and Install Plugins .... Start typing the name of the plugin in the search bar, and it will automatically appear in the list at the bottom
of the dialog. Select it from the list by left-clicking – brief information about the plugin will appear
that you should read; click Install Plugin, and close the dialog.

Upon successful installation, the plugin will appear as a separate panel below the map canvas
window.
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If this panel does not appear, repeat the steps specified in the Figure below.

Adjust the animation by clicking Settings – Add Layer. Select the created layer, specify the Start
time and End time, and click Ok.

Increase the frame to 1000 milliseconds to slow down the animation, click Ok. In the Time frame
field, select days. To run the animation, click and the Play button .
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To save the animation, use the Export video button.
Check yourself
When (date) was the area of oil slick the largest
(specify the area)?
What in your opinion are the consequences of
this oil pollution?
Scan the QR-code below to watch a video tutorial on the performance of this Task.
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8. Performing Regression Analysis Using Raster Data –
Exploring the Relationships Between Features
8.1. Simple Correlation Analysis: Understanding Relationships
Between Temperature and Algal Blooms in the Kamianske
Reservoir
Case
According to researchers of the Institute of Hydrobiology at the National Academy of Sciences of
Ukraine, the algal blooms in the Dnipro reservoirs mainly result from continuous eutrophication of
their aquatic ecosystems, primarily due to over-enrichment with phosphates, decrease in precipitation, higher frequency of low water years, global climate change (especially rising temperatures), and
low flow rates in circulating water reservoirs.1
Task
Explore the relationship between remote data representing the status of the water body during
an algal bloom, namely, threshold spectral indices (vegetation index (NDVI), algae index (NDAI),
and turbidity index (NDTI)), and the surface temperature in the Kamianske Reservoir (until 2017,
known as the Dniprodzerzhynsk Reservoir) using the Landsat 8 satellite image taken on August 12,
2017.
Task performance algorithm:
1. Download the Landsat 8 satellite image taken on August 12, 2017.
2. Using the RS&GIS plugin, obtain the following from the archive: a merged false-color satellite
image, data on vegetation index, and water surface temperature (in degrees) of the territory of the
Kamianske Reservoir as of August 12, 2017.
3. Download the obtained merged true- and false-color images to QGIS and visually compare
them.
4. Download the obtained thermal bands, B10 and B11 (in degrees Celsius) to QGIS, select the
colors, and compare the surface temperatures at different points.
5. Download and visualize the obtained vegetation index.
6. Calculate additional NDAI and NDTI indices for the clipped location.
7. Perform correlation analysis of all obtained thematic raster images (surface temperature in two
bands: B10 and B11, vegetation index (NDVI), algae index (NDAI), and turbidity index (NDTI)).
8. Perform a logical analysis of your results.
Instructions for self-guided work
1. Download the Landsat 8 satellite image taken on August 12, 2017, that captures the territory of
the Kamianske Reservoir. You can download this image from Google Drive at https://drive.google.
com/drive/folders/1z8KYPMU4LJqe1-1g3r9Gs80UPrGA4Cr), or search for it at the USGS Explore
website. Using the same Google Drive link, download the “border_Kamyanske.zip” archive including
the shapefile of the Kamianske Reservoir boundaries, and unzip it to your folder.
2. Using the RS&GIS plugin, export the following from the archive: a merged false-color satellite
image, data on vegetation index, and water surface temperature (in degrees Celsius) for the clipped
territory of the Kamianske Reservoir as of August 12, 2017.
First, add the RS&GIS plugin: select Manage and Install Plugins... under Plugins from the top
menu, and switch to Not installed. In the search bar, start typing the plugin name, RS&GIS, and it
___________________________________________________
1

URL: http://www.nas.gov.ua/UA/Messages/news/Pages/View.aspx?MessageID=3441 https://texty.org.ua/d/static/wrack/
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will automatically appear in the list at the bottom of the dialog box. Select it from the list by leftclicking, and brief information about this plugin will show up automatically. Read the information,
click the Install Plugin button, and close the dialog box. Once installed, the plugin will appear on the
Installed tab and you can see its icon on the toolbar.

This plugin may be used with original satellite data (Landsat 1-8 and LISS), in particular archives.
The unprocessed, “raw” Landsat data (first level processing) can be downloaded from the NASA
and USGS Earth Explorer datasets available at http://earthexplorer.usgs.gov/, or from Google Drive
(select image entitled LC08_L1TP_178026_20170812_2017082 4_01_T1.tar.gz.)
Below, you can see the main window of the plugin, which includes six sections:
1 – Raw data input;
2 – Some more details;
3 – Outputs;
4 – Extra derived outputs – the plugin applies clearly-defined algorithms to raw satellite data to
obtain the most commonly used combinations;
5 – Custom output band expression/s;
6 – Event log window is an interactive window that provides information about the plugin at the
beginning of the operation, and shows the sequence of process stages.
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To perform this Task, first, specify the path to the image file archive (*.tar.gz) in the Raw Data
Input
section: select Compressed file/s from the drop-down list, and in the line below, specify
the path to the corresponding Area of Interest (Aol) shapefile of the Kamianske Reservoir borders
(“border_Kamyanske.zip”) that was previously downloaded from Google Drive and unzipped.
The Ignore “no data” values option is set by default and does not need to be changed.
In the section , Extra derived outputs, tick the boxes next to the following desired outputs for
this Task:
•

True Color Composite (TCC) – a merged Landsat 8 satellite image produced with the combination of bands: B04 – Red, B03 – Green, B02 – Blue; with this combination, the features on
the earth’s surface look similar to how they are perceived by the human eye: the water is dark
blue, and the vegetation (phytoplankton) is green;

•

False Color Composite (FCC) – a merged Landsat 8 satellite image produced with the combination of bands: B05 – NIR (near-infrared), B04 – Red, B03 – Green; with this combination,
the vegetation appears in shades of red (in our case the intensity of red is indicative of the
phytoplankton concentration, i.e. algal blooms;

•

Normalized Difference Vegetation Index (NDVI) – a simple quantitative indicator of the
amount of active photosynthetic biomass (commonly referred to as the vegetation index);

•

Land Surface Temperature (LST) – a radiant temperature of the earth’s surface, measured
by the Landsat satellite sensors, taking into account albedo, vegetation cover, and soil moisture.

179

To run the plugin, click the Start Processing button. The interactive summary of all processes
performed in the background will display in the Event log window
as text messages.

You will also see a new Windows Explorer window appearing on your screen and displaying a
path to new data; while performing the command, the plugin automatically creates a new folder
called “NITK_RSGIS_*data*_*time*”, where all extracted and unprocessed input data are stored in
the “Extracted” folder, clipped bands in the “Clipped” folder, and the newly created final results in the
“Outputs” folder.
Important! Please note that it will not take much time to process your image with RS&GIS
plugin, and the folder appears when the operation is completed.
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The contents of the Windows Explorer folder that was created using the plugin

Once you have the outputs (six raster images), drag them one by one from the Windows Explorer
window to the QGIS project window for further analysis that is described below. We will proceed
now to outputs review.
3. Download the resulting merged false- and true-color images to QGIS and visually compare
them.
First, take a closer look at the merged satellite images from the “Outputs” folder, namely the files:
LC8[178_26](2017-08-12_time)FCC.TIF and LC8[178_26](2017-08-12_time)TCC.TIF. To improve
the visualization of these images, we shall adjust the contrast and remove the dark background.
To adjust the contrast of the merged image, double-click on its name in the Layers tab to open
the Layer Properties menu. Switch to the Symbology tab, and select No enhancement from the Contrast enhancement list of options, and click Ok. To remove the dark background on the border of
the clipped image, go to the Transparency tab, and enter “0” in the Additional no data value box,
and click Ok. Repeat these steps for another image (LC8[178_26](2017-08-12_time)FCC.TIF or
LC8[178_26](2017-08-12_time)TCC.TIF).
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Adjusting the contrast

Removing dark background

Compare these two satellite images of the Reservoir and choose the merged image (false- or truecolor) that suits you best and facilitates the identification of water blooms.
How may the areas of algal blooms be identified on satellite images?
For visual identification of the areas of water blooms, it is better to focus on the image texture. The
areas of intense algal blooms are often characterized by a specific filamentous texture. In particular,
you can see on the satellite images the areas of intense water blooms extending along the streams
and integrating into the vortex motions in the background of a uniform dark water surface. During
extended periods of warm, sunny, and windless weather, cyanobacteria aggregate into colonies that
float to the surface and form massive surface or subsurface mats that can be easily recognized by their
bright color.

True Color Composite (TCC)

False Color Composite (FCC)

Check yourself
Take a closer look at the merged image of the
Kamianske Reservoir and explore the distribution
of water blooms. What were the directions of the
current and the wind at the time the image was
taken?
4. Download the thermal bands, B10 and B11, to QGIS (in degrees Celsius), select the color gamut, and compare the surface temperatures at different points.
Now, we will proceed to the analysis of bands that represent the surface temperatures in the
Reservoir. We will use the following files from the “Outputs” folder for the analysis: LC8[178_26]
(2017-08-12_time)LST_B10.TIF and LC8[178_26](2017-08-12_time)LST_B11.TIF. B10 and B11
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are the far-infrared bands. Their wavelengths range from 10.30 to11.30 μm (B10), and from 11.50
to 12.50 μm (B11), and they almost similarly reflect the surface temperatures. When analyzing the
thermal band, uncheck the display of other satellite data to avoid interference.
For a better visual understanding of the temperatures distribution, you can select a color ramp for
the thermal band ranging from blue to red: double-click with your left mouse button LC8[178_26]
(2017-08-12_time)LST_B10.TIF file name, and select the display mode, Singleband pseudocolor,
Interpolation → Discrete in the Layer Properties dialog under Symbology. Set the Color ramp, for
example, blue and red (entitled Spectral), and select Invert Color ramp and Quantile mode.

Using the Identify tool, check the temperatures at different points within the Reservoir with one
of the thermal bands, for example, B10, namely in the areas affected and unaffected by algal blooms.
First, find the
icon in the toolbar (the Attribute Toolbar). If this icon is missing, you can switch
it on: right-click within the area of the toolbar and tick the Attribute Toolbar box. Select the icon,
point the arrow at the area of your interest, and click it with your left mouse button. All the information about the identified pixel of the thermal band will display in the Identify Results sidebar. Pay
attention to the Value in the Band1 field – this is the surface temperature in degrees Celsius at the
selected point.
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Check yourself
What is the surface temperature in the parts of
the reservoir with the largest accumulation of water blooms? Is it above or below the temperature of
the areas unaffected by the algal blooms?
5. Download and visualize the obtained vegetation index.
Now, we will proceed to the visual interpretation of another file, namely the vegetation index
obtained with the RS&GIS plugin: download LC8[178_26](2017-08-12time)NDVI.TIF file from the
“Outputs” folder to your project, and choose another color ramp for its display. To do this, right-click
the NDVI raster in the project content table and select Properties from the drop-down menu. In
the Layer Properties window that appears, go to the Symbology tab and select the Singleband pseudocolor display mode, and pick Discrete under Color Interpolation. You shall also change the Color
ramp to generate a required index map display. This is not necessary, however, as our main task is to
determine a correlation between different remote sensing data relating to the Reservoir.
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Vegetation index
6. Calculate additional NDAI and NDTI indices using the clipped bands.
Next, we will calculate two additional indices that characterize the water blooms in the Kamianske
Reservoir, namely the algae index (NDAI) and the turbidity index (NDTI).
First, download to your project the clipped bands (B2, B3, B4, B5) obtained in Section 2 of this
Task with the RS&GIS plugin. They are stored in the “Clipped” subfolder of the same PC folder as an
input image downloaded from Google Drive, NITKTtSGIS_*data*_*time*.
The Normalized Difference Algae Index (NDAI) is well-suited for detecting the algae overgrowth
and its stage. It has been designed in such a way as to neutralize the atmospheric interference on the
one hand, and remove water background reflectance on the other hand, and also take into account
the detected spectral characteristics of scattered and concentrated phytoplankton. The higher the
value of the index, the more intense the water blooms, and vice versa – low values indicate water
unaffected by algal blooms.
NDAI = (Green + 2 *NIR - Blue - Red)/(Green + 2 *NIR + Blue + Red) + 0.5
де: Green – зелений діапазон, NIR – ближній інфрачервоний діапазон, Blue – блакитний
діапазон, Red – червоний діапазон
The Normalized Difference Turbidity Index (NDTI) is used to evaluate the water turbidity mainly
caused by suspended particulate matter in surface layers and the activity of organisms. Uneven distribution of suspended solids is an important environmental parameter used in water quality assessment.
NDTI = (Red - Green)/(Red + Green)
where: Red – red range, Green – green range
These indices may be calculated with a raster calculator, which has been repeatedly used in previous tasks. First, switch to the Raster tab → Raster Calculator dialog in the main menu. In the appropriate field of the Raster Calculator box, enter the expression for calculating the required index (first,
the NDAI and then, the NDTI.
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NDAI formula for Landsat 8 satellite image:
((B3 + (2 * B5) - B2 - B4))/((B3 + (2 * B5) + B2 + B4)) + 0.5
NDTI formula for Landsat 8 satellite image:
(B4 - B3)/(B4 + B3)
Important! Please note that the decimal separator (point, comma) that suits best for expressing
decimal numbers in Raster Calculator depends on your PC settings.
Select the desired bands from the Raster Bands list in the Raster Calculator dialog (at the top of
the window). Use the appropriate Operators buttons to select the symbols (), -, +, /. To add layers to
the expression dialog, double-click on the desired layer with your left mouse button.
Important! Do not enter band names from the keyboard as the formula will not run.
Please note that the Ok button at the bottom of the Raster Calculator will activate once you
specify a name and a path to the Output layer. Select the required folder by clicking the
button, and write the name of the output layer, for example, “NDAI_2017_08_12”, where the numbers
indicate the image date. Repeat all the above steps and you will get the turbidity index file called
“NDTI_2017_08_12”.
Important! If you can’t save the file, check the names of folders and files: you should not use
Cyrillic and space characters in the names.

Calculating algae index in the Raster Calculator window
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Thus, using the above procedure, you will add two more thematic raster images to your project,
namely, the NDAI algae index and the NDTI turbidity index, which characterize the quality of water
in the Kamianske Reservoir and will be required for further correlation analysis.
Check yourself
What algae is responsible for water blooms?
What processes and phenomena contribute to
the water bloom?
7. Perform correlation analysis for all obtained thematic raster layers (surface temperature in two
bands (B10 and B11), vegetation index (NDVI), algae index (NDAI), and turbidity index (NDTI)).
To perform raster correlation, use the r.covar tool: select Toolbox from the Processing tab. Enter
r.covar in the search field of the Processing Toolbox dialog, and select it from the drop-down list.
This tool provides a covariance/correlation matrix for user-specified raster layers.
Under the Input layers in the r.covar dialog, specify all required data, namely, five thematic layers
(two thermal bands (LST_B10, LST_B11) and three indices (NDVI, NDAI, NDTI )), and click the
Run button.

As a result, you will get a Covariance report in HTML format. To open the report, click the link
at the bottom of the window.
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Correlation report on the water quality parameters in the Kamianske Reservoir obtained with
QGIS
8. Logical analysis of results.
The symmetric covariance/correlation matrix, N x N, will be the output of your analysis of water
quality in the Kamianske Reservoir, where N is the number of raster layers specified in the command
line, in our case:
X 1 – corresponds to B10 values, i.e. the surface temperature of the Reservoir in the band 10;
X 2 – corresponds to B11 values, i.e. the surface temperature of the Reservoir in the band 11;
X 3 – corresponds to NDVI values, i.e. the vegetation index;
X 4 – corresponds to NDAI values, i.e. the algae index;
X 5 – corresponds to NDTI values, i.e. the turbidity index.
X1 – B10
X2 – B11
X3 – NDVI
X4 – NDAI
X5 – NDTI

X1 – B10
1
0.981
0.708
0.699
-0.695

X2 – B11
1
0.685
0.676
-0.660

X3 – NDVI
1
0.955
-0.880

X4 – NDAI

1
-0.853

X5 – NDTI

1

Correlation analysis is a statistical method used to measure the relationship between random
variables. The correlation can be positive or negative (or zero if there is no statistical relationship
between independent random variables). A negative correlation is a relationship in which an increase
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in one variable is associated with a decrease in another. A positive correlation is a relationship in
which an increase in one variable is associated with an increase in another.
Covariance is a measure of how much two random variables vary together. Correlation is a
statistical measure that expresses the extent to which two variables are related.
The analysis of obtained results shows a positive correlation between B10, B11, NDVI, NDAI and
a negative correlation with NDTI
Important! The closer the correlation coefficient to 1, the stronger the relationship between the
two variables. Each variable has the maximum similarity to itself, i.e. the correlation is equal to 1; however, it is not logical to compare the variable with itself, so when searching for the highest correlation we
should not consider pairs with a correlation coefficient equal to 1.
Table: Correlation coefficients and the extent of the relationship according to the Chaddock scale
Correlation
coefficient

Extent of
relationship

Results obtained for the
Kamianske Reservoir

1,00

Functional
relationship

1

0,90–0,99

Very strong

0.981, 0.955, -0.880, -0.853

0,70–0,89

Strong

0.708

0,50–0,69

Significant

0.685, 0.676, 0.652, -0.695,
-0.660

0,30–0,49

Moderate

0,10–0,29

Weak

0,00

None

According to the matrix given above, the highest correlation coefficients are observed for the relationships between the B10 and B11 thermal bands, and the turbidity and algae indices; it is not correct,
however, to compare them in pairs because these variables are very similar. Our task was to determine
the relationship between the temperatures and water blooms, this means to compare different thermal
bands and water quality indices and select the highest value for the extent of the relationship.
Check yourself
Which of the analyzed remotely sensed data
have the strongest relationship?
Scan the QR-code below to watch a video tutorial on the performance of this Task.
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8.2. In-Depth Regression Analysis of the Relationships between
the Remotely Sensed Data of the Kamianske Reservoir
Understanding any natural phenomenon requires knowledge of its relationships with others. To
capture the essence of phenomena, it is necessary to explore their relationships, determine the extent
of impact exerted by certain factors. Correlation refers to an incomplete relationship between the
studied phenomena. This is a sort of dependence where any value of one variable can correspond to
several different values of another variable.
Regression analysis involves the identification of the relationship between one variable and one
or more other variables; in contrast to correlation analysis, it focuses on a model of such relationship
that is used to develop a regression equation rather than the extent of the relationship.
Task
Perform an in-depth regression analysis of remotely sensed data: water surface temperatures and
threshold spectral indices of water blooms (vegetation index, NDVI, algae index, NDAI, and turbidity index, NDTI) of the Kamianske Reservoir (until November 8, 2017, known as the Dniprodzerzhynsk Reservoir) using the Landsat 8 satellite image taken on August 12, 2017.
Task performance algorithm:
1. Create a shapefile (polygon grid) and select the area of interest within the Kamianske Reservoir.
2. Extrapolate data of thematic raster layers (surface temperatures in two bands, B10 and B11,
vegetation index (NDVI), algae index (NDAI), and turbidity index (NDTI)) to the attribute table of
the shp-file (grid of rectangle polygons).
3. Export the attribute table containing the thematic raster layers from the shp-file to the CSV-file.
4. Perform a regression analysis in Microsoft Excel using the correlation and regression tools.
Instructions for self-guided work
1. Create a shapefile (polygon grid) and select the area of interest within the Kamianske Reservoir.
To perform this Task, we need five basic raster images obtained in our previous Task, namely: the
surface temperatures of the reservoir in two bands: B10 and B11, vegetation index (NDVI), algae
index (NDAI), and turbidity index (NDTI). First, download them from the “NITK_RSGIS” folder
created with the RS&GIS plugin to a new QGIS project.
Next, create a shapefile (polygonal vector with a grid), which attribute table will be used to extrapolate the data from each cell of the polygon of five input raster images. To create a shapefile, use
the Create grid tool. First, select the Toolbox service from the menu bar under Processing. In the
Processing Toolbox search field, type “create grid” and select it from the drop-down list.
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In the Create Grid dialog, specify Rectangle (Polygon) as the Grid type, and pick Select Extent on
Canvas from the drop-down list in the Grid extent (Xmin, Ymin, Xmax, Ymax) field. You will see
that the dialog box disappears, and you have to select the desired size of the area of interest on the
Reservoir’s map extent to be covered by the grid by pressing and holding down the left mouse button.
We recommend selecting a rectangular extent at the widest part of the Reservoir to avoid any empty areas with zero values. Specify the width and height of the polygonal grid cell in the Horizontal
spacing and Vertical spacing fields by entering a value of 500. In addition, configure the save options
for the shapefile you want to save to your PC, name it “Grid.shp” and click the Save to File button.

Configuring the Create Grid tool
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The red color indicates the area selected in the Select Extent on Canvas field that will be covered
with a grid.

As a result, you will get a grid layer entitled “Grid”.
2. Extrapolate data of thematic raster layers to the attribute table of the shp-file (grid of rectangle
polygons).
To extrapolate the data of all thematic raster layers (surface temperatures in two bands, B10 and
B11, vegetation index (NDVI), algae index (NDAI), and turbidity index (NDTI)) to the attribute
table of the created polygonal grid layer, use the Zonal Statistics tool. This tool calculates statistics
for the pixels of an input raster within certain zones/polygons. First, go to the Toolbox that is located
in the top menu under Processing. In the Processing Toolbox dialog, enter “zonal statistics” in the
search field and select it from the drop-down list.
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In the Parameters dialog, select the first thematic raster layer that is opened in your project from
the list under the Raster layer, e.g. the thermal layer entitled LC8[178_26](2017-08-12_08-31)LST_
B10, pick Grid from the drop-down list under the Vector layer containing zone, and indicate the
name of the input thematic raster layer in the Output column prefix box, i.e. in this case – the thermal band B10 (type “B10”), and click the Run button.

You should repeat the described above procedure with the Zonal Statistics tool for each thematic
raster layer (in our case, there are five layers). This can be done without closing the tool’s dialog box:
simply specify each raster in the Raster layer field and indicate its name in the Output column prefix
field to create the appropriate attributes.
As a result, you will get the shapefile containing a “Grid” table of statistical attributes for each cell
of all five thematic layers. To view the table, select Open Attribute Table. The table contains the following columns for each of our raster layers:
• Count: shows the number of pixels;
• Sum: summarizes the value of pixels;
• Mean: shows the average value of pixels.
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Check yourself
Take a closer look at the resulting attribute table
and try to answer the question: What is the total area
of the Reservoir selected and covered by the grid if
one grid cell is 500x500 meters?
3. Export the attribute table with the values of thematic raster layers from the shp-file to the CSVfile.
The next step is to save the resulting attribute table values from the shapefile to Excel using the
MMQGIS plugin.
To install this plugin, select Plugins - Manage and Install Plugins ... from the top menu and
switch to the Not installed tab. Start typing MMQGIS in the search field and the plugin will automatically appear in the list at the bottom of the window. Select it from the list by left-clicking, and brief
information about the plugin will pop up; read this information, and click the Install Plugin button,
and close the dialog. Once installed, the plugin will appear in the Installed tab and its name will be
displayed in the toolbar.

We will use the Attributes Export to CSV File tool of this plugin that saves the attributes from
a grid layer to a CSV file, which can be later viewed or edited in Excel. Select MMQGIS → Import /
Export → Attributes Export to CSV File from the toolbar.
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In the Export Attributes dialog, specify the following:
Input Layer: the name of the map layer that contains the attributes for export – “Grid”;
Attributes: you can pick several attributes from the multiple selection list; hold down the CTRL
key and select several fields, namely: “_B10mean”, “_B11mean”, “_NDVImean”, “_NDAImean”,
“_NDTImean”;
Delimiter: data delimiter for the output file field – semicolon;
Decimal Mark: the decimal character of the output file – comma;
Line Terminator: terminator symbol of the output file – CR-LF (Windows);
Output CSV File: the name of the output file, for example: “regres_2017.csv”.

This was our final task in QGIS, which output is a statistical table of five different remotely sensed
parameters of the Kamianske Reservoir determined based on the Landsat 8 satellite image taken on
August 12, 2017.
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4. Perform regression analysis in Microsoft Excel.
We will proceed now to the data analysis with the Excel program.
4.1. Open the file of statistics saved in the previous step, “regres_2017.csv”.
Important! If the statistical information is not displayed on your device correctly (automatic
breakdown into five columns (different remotely sensed variables) is missing), use the Text to Columns
tool from the Data tab of the Excel menu. Select the first column and choose the tab character from the
tool’s dialog box (comma, point, space, semicolon, etc.) to break down the information in the table columns. However, it may be that the statistical information is displayed correctly, in which case you just
need to save the resulting file.
4.2. Replace all points in the data table with commas for correct visualization of data: switch to the
Home tab, go to Find & Select and click the Replace tool. Indicate a point in the Find what box and
a comma in the Replace with field under Find and Replace, and click the Replace All button.

Replacing points with commas in Microsoft Excel
4.3. Activate Data Analysis.
To perform the regression analysis, you must first turn on the Data Analysis function. The tools
required for the analysis will appear in the Excel menu upon activation of this function.
Therefore, first, switch to the Options tab under File, and go to the Add-Ins tab. At the bottom of
the window, select Excel Add-ins from the Manage box (in the cases where another option is specified in the Manage box), and click the Go button.
In the new Excel add-ins window, tick the box next to the Analysis ToolPak add-in, and click Ok.
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“regres_2017.csv” statistics file opened in Excel

Adjustment of settings

Path for activation of the Data Analysis function in the Microsoft Excel program
(for regression analysis)

Path to Excel add-ins

Selecting required add-in

Підключення пакета Data Analysis (Аналіз даних) для визначення регресійного
аналізу в програмі Microsoft Excel компанії «Microsoft»
Activation of the Data Analysis function for the regression analysis with the Microsoft Excel
program.
Once the above-mentioned steps are completed, a new button, Data Analysis, will appear in the
Analysis tab under Data.
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4.4. We will proceed now to the analysis of the outputs starting with correlation analysis.
Correlation analysis is a statistical method used to measure the relationship between random
variables in one or two samples.
A correlation means that an increase in one variable is associated with an increase (positive correlation) or decrease (negative correlation) in another variable. Correlation analysis makes it possible
to use the value of one variable to predict the value of another.
The correlation coefficient is denoted by r and represented as a value between +1 to -1.
To perform the correlation analysis, go to the Data tab and click the Data Analysis button. You
will see a list of different data analysis options. Select Correlation from the list, and click Ok.

Correlation analysis with Microsoft Excel
As a result, the Correlation dialog will appear. Specify the interval for all columns included in
the analysis (without headings) in the Input Range field. In our case, these are the datasets from the
following columns: _B10mean, _B11mean, _NDVImean, _NDAImean, _NDTImean.
The Grouped By default setting is Columns – leave it unchanged because our datasets are grouped
into five columns.
The Output options default setting is New Worksheet Ply, i.e. the data will be displayed on a new
worksheet. Now that you have configured Correlation, click the Ok button.
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Defining data for correlation analysis with Microsoft Excel
On completion, an output matrix table will appear in a new Excel sheet, which displays the Pearson’s correlation coefficients for five remotely sensed parameters of the Reservoir, namely:
Column 1 represents the values of B10mean, i.e. the Reservoir’s surface temperatures in band 10.
Column 2 shows the values of B11mean, i.e. the Reservoir’s surface temperatures in band 11.
Column 3 shows the values of NDVImean, i.e. vegetation index.
Column 4 represents the values of NDAImean, i.e. algae index.
Column 5 shows the values of NDTImean, i.e. the turbidity index.
Correlation is used to determine which parameters impact each other, while regression determines
the nature of the impact. The correlation coefficient characterizes the strength of the relationship
between two variables. For example, R2 = 0.76 = 76% - coefficient of determination that shows the
proportion of variance in the dependent variable that can be explained by the independent variable.
Important! Our main task is to determine the impact of temperature on water blooms.

The Pearson’s correlation coefficients for five parameters displayed in Microsoft Excel
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Запитання для перевірки
Take a closer look at the resulting correlation
matrix and answer the question: What index
(vegetation, algae or turbidity) has the highest
correlation with the thermal band 10?
4.5. We will perform now a regression analysis of several of the most highly correlated parameters
in pairs.
Go to the Data Analysis tab and select Regression from the drop-down list, and click Ok.
In the Regression dialog that opens, we need to set the values of Input Y Range and Input X
Range. All other settings can be left unchanged (default).
In the Input Y Range field, indicate the address for the range of cells that contain the variables under study. In our case, these will be the cells of the column “temperature – B10”. In the Input X Range
field, specify the address for the range of cells that contain data of the factor, which impact we want
to determine, for example, cells of column 5, “NDAI” and click Ok.

Data analysis interface for the performance of regression analysis
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Settings in the Regression dialog of the Microsoft Excel program
Please note that our main task is to determine the impact of temperatures on water blooms. The
temperature datasets are provided by two bands, B10 and B11, and algal blooms can be assessed
based on three indices (vegetation, algae, and turbidity). Therefore, it is not reasonable to intercompare two temperatures or three water blooms indices. We will compare one pair first: temperature
“B10” and algae index “NDAI”. After that, using the Regression tool, we will compare one-by-one the
following pairs: temperature “B10” and turbidity index “NDTI”, temperature “B10” and vegetation
index.
4.6. Reviewing the results of regression analysis
The tabulated results of the regression analysis measuring the impact, for example, of the temperature on the turbidity, are displayed on a new sheet according to the settings.
One of the main variables is R Square. It indicates the quality of the model. In our case, this coefficient equals 0.54, or about 54%. The higher the coefficient of determination (R2), the better the
model fits the data. If the R2 value is above 0.8 this model is considered Good, if the R2 is below 0.5
such model is considered to have a weak predictive accuracy (the output can hardly be considered
reasonable). In our example, the model has Moderate accuracy.
Another important variable located at the intersection of the X Variable 1 and Coefficients shows
the level of dependence of Y on X. In our case, this is the level of water turbidity dependence on
temperature. The coefficient of 10.16 is considered to be a sufficiently high indicator of dependence.
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The results of regression analysis identifying the relationship between temperature and NDAI
As can be seen from the examples given above, it is quite easy to make the regression table in Microsoft Excel. Further processing and understanding outputs, however, requires an in-depth study
of regression and correlation analyses concepts. Therefore, we recommend that you obtain a good
knowledge of these methods that are essential for numerous scientific studies.
To complete the analysis, you can also build a chart scatter for the two most dependent features in
Excel using the Insert → Chart Scatter tools, and select an express layout to display a trend line and
an equation for the trend line with a coefficient of determination (R2).
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Results of regression analysis represented as a chart scatter for the relationship between
temperature and NDAI
Check yourself
Perform a regression analysis to measure
the dependence of the vegetation index on the
turbidity index and specify the coefficient of
determination (R2).
Justify the strength of the relationship. What
has caused it?
Scan the QR-code below to watch a video tutorial on the performance of this Task.
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Annex
The Appearance of Different Types of the Earth’s Surface Available in Ukraine
Surface Type

Photo

Appearance on Satellite Image

Deciduous Forests
(change their color
depending on the
season)

Coniferous Forests
(stay green all winter)

View of the deciduous forest in the Carpathian Mountains

View of the coniferous forest in the Carpathian Mountains
Mixed-Species Forests
(in winter, it is possible
to differentiate easily
coniferous trees from
deciduous ones)

View of the mixed forest in the Carpathian Mountains
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Thin (Sparse) Forests
(forests in which the
trees do not form a
closed canopy)

View of the sparse oak forest near Kyiv
Shrubs
(woody plants less than
2 m tall that do not
provide deep shade)

View of the shrubs on the left bank of the Kaniv Reservoir
Meadows, Pastures
(are characterized by the
intense green color and
smooth shape)

View of the meadows in the Desna River floodplain
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Fields
(are characterized by
geometric rectangular
shapes and varying
colors depending on
the season and crop
rotation)

View of the fields in Boryspil District of Kyiv Oblast
Sands
(are characterized by
intense, bright color
against a background of
vegetation)

View of the sand spits at the Desna River
Settlements
(are characterized by
a uniform transport
network that can be
clearly seen)

View of Vyshhorod
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Bodies of Water
(rivers have a tortuous
shape and appear deep
blue)

View of the Dniester River
Swamps
(in winter, they appear
light brown with wet
spots)

View of wetlands at the upper Kyiv Reservoir
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List of Tools
Add Item
Add Polygon Feature
Additional no data value
Atmospheric Chemistry
Back to Data Selection
BackSpace
Datasets
Data source
Analytical
Attribute Toolbar
Categorized
Change Color
Change Opacity
Classify
Color ramp
Continuous
Contrast enhancement
Discrete
Equal interval
Event log window
Extra derived outputs
Export color map to file
False color
False Color Composite (FCC)
Frame
Geoprocessing Tools
Identify
Identify Features
Interpolation
Interpretation
Invert Color ramp
Layers
Layer Properties
Linear
Load color map to file
Manage and Instal Plugins...
Map Canvas Extent
Max. cloud coverage
Measure
Measure Area
Measure Line
Measurements
Merge
Merged
Miscellaneous
Mode
Monthly and Seasonal Averages
Multiple selection
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New shapefile layer
New Spatial Bookmarks
No enhancement
Ok
Opacity
Open Attribute Table
Open Data Source Manager
Operators
Options
Output column prefix
Plot Data
Print Layout
Processing
Processing Toolbox
Project
Properties
SpatialSwipe Bookmarks
Symbology
Quantile
Raster
Raster Bands
Raster Calculator
Raster calculator expression
Rename layer
Render type
Re-Plot
Results Viewer
Run
Select Date Range (UTC)
Select Date Range
Select extent on canvas
Select Plot
Select Region (Bounding Box or Shape)
Select Seasonal Dates
Select variable
Settings
Single labels
Singleband presudocolor
Scatter, Area Averaged (Static)
Spectral
Swipe
Time Series Area-Averaged
Time-Averaged Map
Toggle Editing
Toolbars
Toolbox
True color
True Color Composite (TCC)
Value
Vector layer containing zone
View
Zonal statistics
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Навчальне видання
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Кучма Тетяна Леонідівна
Юрків Лілія Ярославівна
Томченко Ольга Володимирівна

Робочий зошит
«Аналіз космічних знімків у геоінформаційних системах»
Частина 2

Коректура І. В. Братащук
Верстання О. А. Жупанська
Дизайн обкладинки Б. Л. Лісовський
Формат 60×84 1/8. Папір офс. 80 г/м2.
Друк цифровий. Ум. друк. арк. 24,49.
Наклад 300 прим.
Видавництво: Національний центр «Мала академія наук України»,
Кловський узвіз, буд. 8, м. Київ, 01021
Свідоцтво суб’єкта видавничої справи:
ДК № 6999 від 04.12.2019

Робочий зошит є практичним доповненням до навчально-методичного посібника «Дистанційне
зондування Землі: аналіз космічних знімків у геоінформаційних системах» (С. О. Довгий, С. М. Бабійчук,
Т. Л. Кучма, О. В. Томченко, Л. Я. Юрків). Практичні роботи, що містяться в робочому зошиті, укладені
з метою познайомити читача з можливостями застосування відкритого програмного забезпечення –
Quantum GIS у дослідженнях, зокрема кліматичних, гідрологічних, лісових, сільськогосподарських
тощо. Робочий зошит може використовуватися методистами і керівниками секцій системи Малої
академії наук України, вчителями й учнями шкіл, ліцеїв, гімназій в освітній та дослідницькій діяльності,
а також усіма, хто прагне самостійно опанувати основи дистанційного зондування Землі.

